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PART 1: ON1 HDR 2023 OVERVIEW

ON1 HDR 2023 is a full-featured photo editor designed to create rich, detailed high-dynamic-range (HDR) 
images from two to 13 bracketed photos. With HDR 2023, you can take multiple shots of a scene, at 
varying exposure levels—accurately capturing shadows, midtones and highlights in different frames across 
the series—and then blend them together to create a final image that has a much wider tonal range than a 
single shot could do. 

When using ON1 HDR 2023 as a standalone app, there are two primary components, one for the creation 
of an HDR image from a bracketed set of photos, and an editing module for finishing your photos. You can 
also use the batch-processing feature to create multiple HDR photos from a group of brackets taken at 
different times. To get started with a series of bracketed photos, see “Creating HDR Images” on page 16.

The Edit module has three tabs—Develop, Effects, and Local—each with a specific area of functionality: 
Develop for basic tonal editing, Effects for stylization, and Local for targeted editing of specific areas in 
your images. Information on using the Edit module starts on page 20.

The Edit module also supports a layered workflow, for creating blended composites from multiple images. 
You can use this feature to fine tune your HDR photos even further. For more on Layers, see page 95.

Once you’ve completed your finished HDR photos, you can print, export and share them directly from 
within ON1 HDR. See page 101 for complete information on these features.

ON1 HDR also works as a plugin for Adobe Lightroom Classic and Capture One, giving you full access to all 
of the tools found in the standalone app. When used with Lightroom and ON1’s Smart Photos feature, you 
also have full re-editing capabilities inside ON1 HDR.
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Getting Help
You can find an extensive collection of 
video tutorials and help documents for 
HDR in the Help section of the ON1 
website (on1help.zendesk.com). This is 
the quickest way to dig into the app. 
There, you can search our Knowledge 
Base for frequently asked questions, 
and more. 

Inside ON1 HDR, you can use the 
Learning Hub to directly display videos 
for getting started with the app, search 
the ON1 online help system—including 
with and online chat assistant—and the 
ON1 Shop, where you can purchase 
add-ons and courses for ON1 HDR.

The Learning Hub is accessible via the Help menu or from the Help icon at the bottom left bumper panel.  

System Requirements
MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.15.6 and above; Windows 10/11 
(current maintenance releases, 64-bit only)

macOS 12 or Windows 11 
(current maintenance releases, 64-bit only)

PROCESSOR Intel or AMD processor with 64-bit support, 2 GHz or faster with SSE 4.2 or later;  
Apple Silicon

RAM 8 GB 16 GB or more

HARD DRIVE 2 GB for installation 2 GB for installation; SSD drive

DISPLAY Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 2GB VRAM, 1920x1080 
resolution (at 100% scale factor)
macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 2GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 8GB VRAM, 1920x1080 
resolution (at 100% scale factor)
macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 8GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

OPTIONAL APPLICATION 
INTEGRATION

Photoshop Lightroom Classic CC 2020 and above; Capture One 10 and above

INTERNET A high-speed internet connection and active account for activation, auto-update 
checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports ICC/ICM profiles for camera input, display, soft-proofing, and printing. 
Hardware display calibration tool is recommended.

LANGUAGES English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch

The Learning Hub is available directly within ON1 HDR 2023, and includes links to videos 
(which can be played directly in the Hub), ON1’s online help system, and the ON1 store.
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Installation
To install ON1 HDR 2023, you must first 
download and install the ON1 Application 
Manager, which manages your ON1 applications 
and free trials. Once you’ve installed the 
Application Manager, double-click on the app 
icon. You will first be prompted to sign in to your 
ON1 account. The Application Manager will then 
communicate with the ON1 servers, and display 
any apps you already have installed, as well as 
any newer apps that are available for your 
account. To install HDR, choose Available from 
the list on the left side of the window, and click 
on the Install button for the ON1 HDR AI 2023 
item. The Application Manager will install HDR 
in the proper location, and add it to the Installed 
section. From there, you can open the app. The 
first time you launch HDR AI, you’ll need to sign 
in again to your ON1 account; after that you’re 
software will be authenticated.

Your license lets you install HDR on two com-
puters. When you enter your ON1 account info, 
your software is registered for that computer.

If you wish to move your copy of HDR from one 
registered computer to a new one, and you are 
not going to be using the older machine, it is 
best to sign out of the old computer first. Open 
HDR and select Sign Out from the Help menu. 
This will deactivate HDR 2023 on the current 
machine, and you can install and sign in on 
another machine from the Application Manager.

FREE TRIAL VERSION

ON1 HDR 2023 can also operate as a fully 
featured trial version for 15 days from when you 
first launch it. This gives you time to evaluate 
the product and see if it fits your needs. To 
install HDR as a trial, click on the Free Trials 
label in the Application Manager, and click on 
the Install button. The Application Manager will 
display the number for days left in your trial; to 
purchase HDR, click on the Buy button in the 
Free Trials section, or the Buy Now button in the 
top right corner of the HDR window.

The Application Manager is used to install and manage your  ON1 apps and 
plugins. The first time you launch it, you’ll need to sign in with your ON1 
account details.

When using the ON1 Application Manager, the Available section (shown top) 
will list all licensed apps and plugins associated with your account. You can 
install any of those apps by clicking on the Install button, after which they will 
be listed in the Installed section of the Manager.
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MAC INSTALLATION LOCATION
On a Mac, the application is installed in the ON1 HDR 2023 folder in the Applications folder. 

If a previous version of ON1’s HDR, Perfect Photo 10 or Perfect Photo Suite is found, it will be maintained 
or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS INSTALLATION LOCATION
The application is installed in the ON1 HDR 2023 folder in the \Program Files\ON1\ directory. If a previous 
version of ON1’s HDR, Perfect Photo 10 or Perfect Photo Suite is found, it will be maintained or replaced 
based on your preference during installation.

Support files are installed into \ProgramData\ON1\.

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of HDR on your computer, the installation process will move over any presets. 

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 HDR AI 
2023. You can change your participation later, just click the Help menu, then Help Improve ON1 Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Launching ON1 HDR 2023
To launch HDR 2023 as a standalone app, follow these steps:

MACOS

1. Open your Finder and navigate to the Applications folder.

2. Navigate to the ON1 HDR 2023 folder, and double-click on the ON1 HDR 2023 icon.

You can add ON1 HDR 2023 to your dock for easy access by clicking and holding the icon in the dock and 
selecting the Keep In Dock option. If you use Launchpad it can be found there as well.
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WINDOWS 10

1. Open the Start screen by pressing the Window key.

2. Select ON1 HDR 2023.

3. If you selected the “Add Icon to Desktop” option during installation you can also access ON1 
HDR 2023 from there.

NOTE: For information about running ON1 HDR 2023 as a standalone app, see 
“Creating HDR Images” on page 16. To learn how to access HDR as a plugin 
from Adobe Lightroom, see page 6. For information about launching ON1 
HDR as a plugin to Capture One, see page 9.

Uninstalling ON1 HDR 2023
To uninstall ON1 HDR 2023, follow these instructions:

First, deactivate your product: open ON1 HDR 2023 and select Sign Out… from the Help menu. (This will 
allow you to transfer your license to another computer.)

On MacOS, go to the Applications/ON1 HDR 2023/Documentation folder. Double-click on the Remove 
ON1 HDR 2023 application.

On Windows, go to Control Panels. Under Programs select Uninstall a program, and select ON1 HDR 2023 
from the list and click on the Uninstall button.

Working with Files
ON1 HDR 2023 can view and open the following file types, in RGB color, at either 8 or 16 bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

• High Efficiency Image Format (HEIC)

• ON1 Photo format (ONPHOTO)

When you are finished editing a photo in ON1 HDR, the app will save your merged image as a master 
.onphoto file, which you can use to re-edit it at any time. You will also be prompted to save an edited 
version in PSD, PSB, TIFF, JPEG, or PNG format. 
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Using ON1 HDR with Adobe® Lightroom® Classic
ON1 HDR 2023 can also be accessed from within Lightroom Classic CC, providing an integrated, round-trip 
workflow for creating HDR images. Lightroom interoperability gives you the following features:

• Create finished HDR images from a series of bracketed shots (see page 7).

• Re-editability of those finished HDR photos when they’re saved via ON1’s proprietary Smart 
Photos format (see page 8), which saves all your edits made in HDR, for re-editing at a 
later time.

• Editing either single images or a group of images (see page 7).

You access ON1 HDR from Lightroom’s 
File > Plug-In Extras menu item, where you 
will find two options. The first, Merge with 
HDR 2023, is designed to create an HDR 
image from a series of bracketed photos. The 
other, Edit with in HDR 2023, is for editing a 
single image inside ON1 HDR, or for batch-
processing a set of single images using HDR’s Develop, Effects and Local Adjustments tabs.

FILE CHARACTERISTICS WHEN USING ON1 HDR AS A PLUGIN

When you access ON1 HDR 2023 through 
the Plug-in Extras menu, the file handling is 
controlled via the Plug-Ins tab of the HDR 
Preferences window. These options can be 
configured in advance, based on your workflow, 
and, depending upon how you set it up, can 
be changed as desired when working inside 
Lightroom. 

The file export options include the following 
settings:

• File Type: This determines what type 
of file will be created. The default is PSD, which does not support re-editability. You can also 
select Smart Photo PSD, JPG or TIFF, if you prefer those formats. One other option, Same as 
Source, will edit the original file; if that file is a Smart Photo PSD, it will open in that format.

• Color Space: The color space menu determines which RGB working color space is used; 
Adobe RGB 1998, sRGB or ProPhoto RGB.

• Bit Depth: Sets the exported file’s bit depth to either 8 or 16 bits per pixel.

• Resolution: Determines the resolution of the newly created file.

• Stack with Original: When enabled, the new image is stacked with the original image upon 
return to Lightroom from HDR.

• Use Original for Single PSDs: When enabled, if you select a single image in PSD format, the 
original file will be edited, rather than having a copy made.

The Plugin Extras submenu is found in Lightroom Classic’s File menu. 
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• Ask Every Time: When checked, Lightroom will present these export copy options whenever 
you chose an item from the Plug-In Extras submenu. Turning this option off will bypass the 
file-export window inside Lightroom, using the options set in Plug-In Preferences window. 

If you have the Ask Every Time option checked, you’ll be 
presented with the Export Options window (shown on 
the right) inside Lightroom whenever you send an image 
to Effects. The Export Options window lets you adjust 
the file format characteristics as needed, and is designed 
for users with variable workflow needs. If you find that 
you use the same options every time, then you can set 
those parameters in ON1 HDR’s Preferences window by 
unchecking the Ask Every Time option.

PROCESSING BRACKETED PHOTOS IN ON1 HDR FROM LIGHTROOM 

To send a set of bracketed files from Lightroom for HDR processing, select two or more photos in 
Lightroom’s Library module, and choose Merge with HDR 2023 from the File > Plug-in Extras menu. Your 
bracketed set will be exported to ON1 HDR for processing. When you have completed your editing and 
click Done, your merged HDR file will be saved in the format chosen in the Export Options dialog box.

NOTE: For details on using the Merge to HDR function, see “Creating HDR 
Images” on page 16.

EDITING SINGLE IMAGES FROM LIGHTROOM

If you use the Edit in HDR 2023 from the File > Plug-in 
Extras menu, you can either export or edit a single image 
for processing in ON1 HDR, or batch process a group of 
images for editing in ON1 HDR. To edit a single photo, 
select it in Lightroom and choose Edit in from the Plug-
In Extras submenu. The Export Options will now include 
three choices for sending the photo to ON1 HDR:

• Edit a Copy with Lightroom Adjustments, 
which makes a copy of the file that includes any 
edits you have made in the photo;

• Edit a Copy, which copies the original photo 
without any changes made in Lightroom; or

• Edit Original, which sends the original version 
of the photo to HDR (this item is not available 
when the file is in the raw format).

When you have finished with your edits, click Done. HDR will then apply all of the edits, save the file in the 
format you’ve chosen, and return you to Lightroom.

Using Plug-In Extras > Edit in HDR 2023 will give you additional 
options for editing individual (or batched) images.
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Batch-editing Multiple Images from Lightroom

You can also edit multiple (separate) images in ON1 HDR 
via Lightroom. Select the images you wish to work with in 
Lightroom’s Library module and choose Edit in HDR 2023 from 
the Plug-In Extras submenu. The Export Options window will 
open with two batch options:

• Pause on First Photo: Use this option when you 
wish to apply the exact same editing operations to 
a group of photos. This option will open the first 
selected image inside HDR. There, perform any 
editing option you wish, including adding presets, retouching operations, cropping, masks, 
local adjustments and more. When you have finished with your edits, click Done. HDR will 
then apply all of the edits to each image in the group, and return you to Lightroom.

• Pause on All Photos: This option lets you sequentially edit the images in the batch. HDR 
will open each image in the destination tab, where you can edit it as desired. When you 
are finished editing with one photo, click Done, and HDR will save that photo and open the 
next one, with the previous photo’s HDR settings applied. (You can reset any or all of those 
settings as desired.) When you have finished editing the last photo in the group, clicking 
Done will save the image, close HDR and return you to Lightroom.

WORKING WITH SMART PHOTOS

ON1’s Smart Photo technology is a variation of the Photoshop file format that has been engineered 
to preserve all editing and retouching operations made within HDR: filter operations, masks, local 
adjustments, retouching, and so forth.

When you choose Smart Photo PSD as an export option in the Plug-In Extras submenu from within 
Lightroom, ON1 HDR creates a standard Photoshop file with “Smart Photo” at the end of the original file’s 
name. As you work in HDR, all of your editing operations are saved in a ‘sidecar’ file that sits alongside 
the PSD on disk inside the same folder as your original image. When you are done editing and return to 
Lightroom, your edited photo will look as it did in HDR, but is completely re-editable.

To re-edit a Smart Photo from within Lightroom, select the image, and choose Edit in HDR 2023 from the 
File > Plug-In Extras File menu. Depending your ON1 HDR’s Plug-ins Preferences settings, the Smart Photo 
will open automatically, or you will need to select Edit Original from the Lightroom Export Options window.   

There are a few things to know about with regards to Smart Photos and re-editability:

• Smart Photos have been specifically designed to work as a conduit between Lightroom and 
ON1 HDR to preserve re-editability. If you use HDR as a standalone app, you can open and 
view a Smart Photo from within HDR, and can re-edit the photo; as long as your sidecar file 
is present, all of your edits will be present. However, when you complete your edits, HDR will 
create a new file in any of the available file formats (PSD, PSB, TIFF, JPEG, and PNG), but the 
file will be flattened, and your edits will not be preserved. (Your original photo will remain re-
editable via Lightroom, however)

• If you open a Smart Photo in Adobe Photoshop, the layers will be merged into a single, 
composite layer. If you make any edits to the photo and save it, re-editability in HDR will no 
longer be available.

The Batch Options window comes up when you wish to 
send a group of photos from Lightroom to ON1 HDR for 
editing. (If you have the Ask Every Time option set in 
HDR’s Preferences, This will be displayed as a section in 
the Export Options window, and you will be able to set 
the file copy options for the photos in the batch.)
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Using ON1 HDR with Capture One
When you send a group of photos to be merged as an HDR from Capture One to ON1 HDR, Capture One 
creates what it calls a ‘variant’ of each of the photos in the group. Primarily, the variants have a new file 
type, but can also preserve cropping information for each of the brackets. 

To merge HDR brackets inside Capture One, 
follow these steps:

1. In Capture One, open and select the 
photos you want to merge to HDR.

2. From the Image menu, select Image 
> Edit With > ON1 Merge with HDR 
2023.

3. Choose the file characteristics you 
wish to use in HDR—File Type, Bit 
Depth, ICC Profile, and Resolution—
and click the Edit Variants button to 
launch ON1 HDR.

4. When you’re finished editing your 
photo, click the Done button in HDR. Your merged photo will be saved according to the file 
format settings found in the Files window of HDR’s Preferences window (see page 125).

After you’ve returned to Capture One, your new variant will be visible in the current collection.

EDITING SINGLE IMAGES FROM CAPTURE ONE

To send a single image from Capture One to ON1 HDR, select the image, and then choose Edit With > 
Other, and select ON1 HDR 2023 from its location on your hard drive (see “Installation” on page 3 for 
the exact locations for your operating system). 

If you’d like to add ON1 HDR to the application list in the Edit With menu, go to Capture One’s Plugins 
Preferences tab, and click the check box next to ON1 HDR 2023 in the list.
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Extras
ON1 HDR 2023 supports a number of additional file types that can be used in various locations within the 
app. These files are called Extras, and the file types include:

• Presets for use within the Develop, Effects and Local Adjustments.

• Backgrounds that can be imported and used in HDR’s Layers feature.

• Borders than can be imported and used in Layers.

• Textures that can be imported and used in Layers.

• Look-up tables (LUTs) for use with Effects’ LUTs filter.

• Custom brush shapes for use in Local Adjustments layers.

• Watermarks, image files (transparent PNGs) that can be used with the Watermark pane of 
HDR’s Export function.

ON1 includes a number of extras in the product when you install HDR, and you can create your own, or 
add extras downloaded from the ON1 website. You can use the Extras Manager to import and manage your 
own extras, creating categories for each type, and deleting extras that you no longer want.

HOW TO IMPORT EXTRAS

To import extras, choose Manage Extras from the File menu, then follow these steps:

1. Select the type of extras you wish to import from the list of tabs at the top (Presets, 

The Extras Manager lets you import presets, textures, backgrounds, borders, look-up tables (LUTs), 
custom brushes and watermarks for use with the different modules in ON1 HDR 2023.
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Backgrounds, Borders, Textures, LUTs, Brush Shapes, Watermarks) You can only import 
extras of one type at a time.

2. Click on the Import button in the footer of the left column. A dialog will appear where you 
can select the files to import. If you want to import an entire folder, open the folder, select 
the first file, then shift-click on the last file. Click Import when your selection is complete.

3. Select a category for your extras to live in. This is where you will be able to find it inside of 
the ON1 HDR 2023. You can select from an existing category or create a new one.

When your extras have been imported you will see them in the Extras Manager in the category you 
selected, in the type of extra they belong to.

Organizing Presets

The Presets tab of the Extras Manager gives you additional options for working with large groups of 
presets inside Develop and Effects. When you are using the Presets tab, you’ll see ‘+’ and ‘-’ buttons, which 
let you add or delete categories to the list of your presets. 

You can also add subfolders to any of the Presets categories, which can help organize and manage large 
collections of presets. You can use drag-and-drop to move existing categories into another, or you can add 
a category subfolder to an existing category by clicking on the category and then clicking on the ‘+’ button 
in the Extras Manager window. (When you are importing presets, HDR gives you the opportunity to add 
presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets, 
for sharing with other users, or to save seldom used presets for archiving purposes. To export a complete 
category, click on the category in the list on the left side of the window and click on the Export button. 
This will export a folder that contains a single .ONpreset file, which includes all of the presets from that 
category. To export a single preset, click on the preset from the list and click on the Export button.

What Type of Images Can I Import as Extras?

Backgrounds and textures may be any image file that HDR can open, including JPEG, TIFF, raw or 
Photoshop files. Border files must have a large central area that is transparent, so only files that support 
transparency, such as PNG, can be imported as borders. LUTs can be in either .3DL or .CUBE format. Brush 
shapes can either be in the Adobe Brush Preset (.abr) file format, or saved as black-and-white TIF files. 
Watermark files are usually PNG files with transparency, although JPGs can also be used if desired. 

NOTE: If you download an .ONPreset or .ONP file, you can simply double-click 
on it to install it. For more information, see the Presets section of this guide, 
starting on page 56.

USING IMPORTED LUTS IN EFFECTS

You access LUTs from within the LUTs filter in Effects. To use them follow these steps:

1. Open an image in ON1 HDR.

2. In the Filter Options pane, select the LUTs filter type.
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3. From the Category pop-up, select a category you have imported. User-added extras 
categories will appear at the bottom of the category list.

4. From the LUT pop-up in the filter, select an item from the desired category.

NOTE: More information on the LUT filters can be found on page 87. 

USING EXTRAS WITH LAYERS IN THE EDIT MODULE

You can view and add extras to any open document in the Edit module by adding a new layer. Just click 
Layer > Add Layer from the File menu to open up a file browser window on-screen, where you can choose 
installed extras or any file from your computer. For more on this, see page 95. 

USING CUSTOM BRUSH SHAPES IN LOCAL ADJUSTMENTS

Custom brushes are used in Local Adjustments layers to add overlays to a photo. Examples include adding 
clouds, stars and watermarks. For complete instructions on using custom brushes, see page 93. 

USING WATERMARKS WITH EXPORT

Watermarks are often used as overlays over exported photos, usually with a unique logo that identifies the 
photographer and protects it from unauthorized use. ON1 HDR lets you import watermark files and use 
them in the Export and Print windows. For more on using watermarks, see page 107 (Export) and page 
116 (Print).   

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1. Open the Extras Manager in any module (File > Manage Extras).

2. Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3. To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4. To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.
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Customizing ON1 HDR’s Keyboard Shortcuts
You can customize ON1 HDR 2023’s hotkeys via 
the Keyboard Shortcuts window. This window lets 
you view and change the shortcuts for any tool, 
tool option, module, or menu item inside HDR. You 
can assign shortcuts to items that don’t yet have a 
shortcut, build multiple sets of shortcuts as preset 
styles, and create a summary of your shortcuts that 
can be viewed in any web browser.

To view or change the app’s hotkeys, choose 
Keyboard Shortcuts from the Edit menu. By 
default, HDR’s shortcuts will be displayed, 
organized hierarchically by the following groups: 

• Modules, commands for switching 
between Develop, Effects and Local 
Adjustments.

• Develop, for applying tone and color 
adjustments directly from the keyboard 
while you are working in HDR’s Edit 
module. (See “Adjusting Tone & Color 
settings via hotkeys” on page 69 for 
details.) 

• Tools, for the 16 tools available in HDR.  

• Tool Options, for the brush and mask 
viewing options available in any masking tool’s Options Bar.

• Menu, which includes all of ON1 HDR’s menu items. 

You open each group by clicking on the triangle to the left of the group name, or you can use the search 
field at the top of the Keyboard Shortcuts window to search for a command in any of the groups. 

Each command that has an assigned key will display that key in the Shortcut column. The Shortcut field 
will be empty for any command that doesn’t have an assigned key, and any field with a grayed-out shortcut 
means that you cannot modify that command’s keys.

NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste), and the Browse 
module shortcut (G). Also, you can’t use the Escape, Return/Enter, or Delete 
keys as a shortcut.



ON1 HDR 2023 User Guide Part 1: Overview 14

MODIFYING HOTKEYS

The Default preset style’s hotkeys cannot be modified, but you can create your own set of shortcuts by 
double-clicking on any command you wish to add or change. You’ll be asked if you want to create a new 
preset. Clicking Yes will let you name the new preset, and HDR will make a duplicate of the Default set.

At this point, you can change any existing 
hotkeys —or add your own shortcuts for 
commands that don’t have them —by double-
clicking in the Shortcut field for that command. 
The field will be highlighted, and you can press 
the key or key combination you wish to use. If 
that key is used by another command, a dialog 
will come up, informing you of that, and giving 
you the option of either keeping the existing 
hotkey/command combination, or changing it to 
the new command.

When you change a default shortcut to a new 
key combination—even for commands and 
options that didn’t initially have a shortcut—a 
Reset arrow will appear to the right of the 
Shortcut field. Clicking the icon will reset the 
command to its original state, from the Default 
preset style.

To delete a shortcut, double-click in the Shortcut field and press the Delete key. 

The Summarize button at the top of the Keyboard Shortcuts window will create an HTML table of the 
current set of hotkeys. You’ll be asked where to save the file, and double-clicking on it will open that table 
in your default web browser, where you can view or print the list. 

You can return to the original HDR shortcuts by clicking on the pop-up menu at the top of the Keyboard 
Shortcuts window, and choosing Default from the list of preset styles. That menu can also be used to 
create a new preset or to delete an existing one that you created. The Default preset cannot be removed, 
however.

When you add or change a hotkey the first time, ON1 HDR will prompt you to 
create a new preset style, which makes a duplicate of the Default preset. You 
can switch between preset styles—including back to HDR’s Default set—by 
using the pop-up menu at the top of the Keyboard Shortcuts window.

If you try to add a shortcut key combination that is already in use, ON1 HDR 
will let you know, and give you the option of keeping (Cancel) or removing (OK) 
the other command/shortcut.



ON1 HDR 2023 User Guide Part 1: Overview 15

Changing HDR’s font size
By default, ON1 HDR prioritizes the main workspace to focus on photos, using a small font size to display 
panel names, labels, file names any other basic text. You can adjust the default font size to one of three 
settings, Small, Medium or Large, by choosing the General tab of HDR’s Preferences window. Select the 
option from the Font Size pop-up, and restart HDR to have the effect take place.

ON1 HDR has three options for displaying type in the main workspace, Small (left), Medium (middle), and Large (right). To change the size, go to 
the General tab of the Preferences window, and pick the new option from the Font Size window. The change will take effect the next time you 
launch the app.
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PART 2: CREATING HDR IMAGES
When you first launch ON1 HDR 2023, the main window will have two buttons in the center of the screen: 
Open Photos, which lets you open a set of bracketed photos for processing, and Batch Process, which you 
can use to perform an HDR operation on a folder full of bracketed image sets.

NOTE: Once you have created HDR photos with ON1 HDR, the bottom of the 
main startup screen will display a filmstrip of your most recently generated 
images; double-clicking one of those files will open it in the Edit module.

Creating a Single HDR photo
If you wish to create a single HDR photo from a bracketed series of files, click on the Open Photos button. 
Locate the set of images and select all of the items you wish to merge. To select a group of contiguous 
photos (ones next to each other in order), click on the first one you wish to select, then hold down the Shift 
key and click on the last photo. If you want to add noncontiguous photos (ones not next to each other), 
click on the first photo, then use the Command (Mac) or Control (Windows) key and click on each photo 
you wish to compare. When you have your selected photos, choose Open. (You can also open a set of HDR 
brackets by dragging them into the main ON1 HDR startup window.)

Once you’ve selected your bracketed set, the Create HDR window will open, giving you a simple set of 
controls for building your final HDR images.
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The Create HDR window has the following options:

A. The Preview window displays a rendition of your merged HDR image (and is resizable).

B. The Options bar has settings for adjusting ghosting, choosing a default look, and which 
module you wish the resultant image to open in.

C. The Reference panel includes the images used to build the HDR, with their exposure values 
relative to the base image. The image with the outline is the base version used for deghosting; 
the base image for exposure is represented by the lens aperture icon next to the checkmark.

D. Save/Cancel buttons.

Once the Create HDR window is open, you can use the various options to tune your image. You can adjust 
the base image: clicking on the different frames in the Reference panel will choose a different base image 
for deghosting; to select a different base 
exposure image, click on the small lens aperture 
icon in a different image of the series. (By 
default, HDR chooses the image it felt was 
closest to the middle of the series for both 
exposure and deghosting.)

The Default Look options are also designed to 
help get you started, corresponding to style 
options in the Tone and HDR Look panes in the 
Edit module. Natural and Surreal use those 
styles from the HDR Look pane, and the Natural 
Auto and Surreal Auto options also add the Auto 

The four options in the Options Bar’s Default Look popup correspond to 
settings found in the Tone and HDR Look panes in the Edit module. Once 
you’ve built your HDR file, you can go into the Edit module and edit any of the 
settings, add other filters and more.
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Tone option from the Tone & Color pane. They are only designed to be a starting point: You can override 
any of the options by adjusting the settings in the two editing panes.

The deghosting section of the Options 
bar has options to blend portions of 
the frame that might have shifted 
during the image series (things such 
as clouds, flowing water or moving 
branches). Depending upon the 
amount of ghosting, you can choose 
from four levels of deghosting (or 
none). If you wish to see those areas in 
your image that will need deghosting 
applied to them, click the Show 
Ghosting button. Those areas that 
have ghosting issues will be shown 
with a red overlay. Depending upon 
how much movement there was in 
your scene, you can then choose the 
appropriate level of deghosting, or, in 
some instances, cancel and choose a 
different set of images to blend into an HDR.

The Align button in the Options bar is on by default, which means that, during the HDR generation process, 
HDR will attempt to automatically align the images, based on their contents. Turn the Align button off 
when the alignment process results in a bad composite, or when you don’t want HDR to align the images 
(when working with star photography, for example). With the Align feature off, HDR will use the selected 
base image for the HDR process.

Once you have your settings adjusted to the way you’d like them, you can click Save and ON1 HDR will 
build your HDR, saving it in the .onphoto file format (in the same folder as the original bracketed files) and 
opening it in the Edit module. 

NOTE: The .onphoto format is proprietary to ON1, and saves your edits as you 
work, which means you can re-edit your HDR at a later time, and export a new 
file with your changes. If you decide that you wish to use a different HDR Look 
style, or want to add additional effects to your photo, open the .onphoto file in 
HDR and your previous edits will be present.

Using the Batch Processor to Build Multiple HDRs
The Batch Process option in ON1 HDR 2023 lets you take a folder containing multiple sets of bracketed 
shots from a shoot, and automatically turn them into HDR photos ready for editing. The process creates 
separate .onphoto files that can be opened directly in ON1 HDR via the Open Photos option.

With the Show Ghosting option turned on, areas that have ghosting issues will be shown with 
a red overlay.
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To set up your shoot for batch processing, create a master folder, with subfolders that contain each 
individual bracket set inside them. Then, click the Batch Process button and select your master folder and 
choose Open. ON1 HDR will go through the subfolders, building each bracketed set using the default 
settings for the Create HDR window, and saving the merged 
HDR image as an .onphoto file in each subfolder.

After the batch operation is complete, you can open any of the 
merged HDRs via the Open Photos button in ON1 HDR, or by 
double-clicking the .onphoto file in Windows Explorer or the 
MacOS Finder. The photo will open in the Edit module, ready 
for further editing.

Opening other photo types from within ON1 HDR
In addition to letting you create and edit blended HDR photos, ON1 HDR will also open single photos in 
any of the supported file types mentioned in the list on page 5. Use the Open Files button to open 
them, or drag them into the ON1 HDR startup window. Doing this will open the photo in the Edit module, 
where you have the full power of HDR 2023, including layers. This can be helpful when you want to use the 
layers functionality to perform more complex composites from multiple photos (“Combining Photos with 
Layers” on page 95). 

If you open an .onphoto file via the Open Files button, ON1 HDR will open that photo with your previous 
settings intact, using information from the stored .on1 sidecar file.

To set up your brackets for batch processing in ON1 HDR, create a master folder, then add subfolders to it, creating 
each subfolder as an individual set of bracketed photos, as shown in the MacOS screenshot on the left side, above. 
When you run the Batch Process option, the app will go through each folder, and create an .onphoto file (and a .on1 
sidecar file) with the default Create HDR settings (see the screenshot above right). Double-clicking on the .onphoto file 
will open it in the Edit module, where you can further to refine or stylize your photo.
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PART 3: EDIT MODULE BASICS
ON1 HDR 2023’s photo-editing power is found in the Edit module, which consists of three distinct editing 
functions, separated into tabs:

• Develop is where you perform basic, global editing operations—adjusting tone and color, 
removing noise, sharpening and more. (see page 66)

• Effects is the stylization center of HDR, with nine filters that can be stacked in any order, all 
with extensive blending and masking options. (see page 76)

• Local Adjustments are designed to apply targeted edits to parts of your photos, letting you 
perform traditional photo-editing tasks—like dodging and burning—with ease. (see page 89) 

HDR 2023’s Edit module also includes a Layers pane, which lets you stack multiple images together to 
achieve sophisticated composites that aren’t available in many standalone photo editors (see page 95). 

To help you save time and create the looks that you love best, ON1 HDR 2023 also includes a robust preset 
system that lets you save your Edit module settings for applying to other photos. (Presets are discussed in 
detail starting on page 56.)

Workflow in the Edit Module
Once you’ve built your HDR image via the Create HDR screen, you’ll move into the Edit module for finish 
editing and stylization. There, you can work in whatever way suits your creativity. Switching between the 
different tabs in the Edit module is as simple as clicking on the appropriate tab, and, while you work on an 
image, all of your settings in each tab are saved as you edit.

When you are finished editing your photo, click the Done button at the bottom of the screen. ON1 HDR 
will save your edits to the master .onphoto file and also will ask you to export a copy of your finished photo 
at full size, in your choice of formats: PSD, JPEG, TIF, or PNG. You will then be returned to the ON1 HDR 
startup screen, where you can build another merged HDR image, edit another photo, or quit the app.

NOTE: When using HDR as a plugin from Lightroom, clicking Done saves the 
file in the format chosen in the Plug-ins Preference setting (see page 125) and 
returns to Lightroom. When using HDR from within Capture One, clicking Done 
uses the file format chosen in the File Preferences setting (see page 125).

To re-edit your HDR, open the .onphoto file, either by choosing it from the Open Photos button in the ON1 
HDR startup screen, or by double-clicking it in Windows Explorer or the MacOS Finder.

If you would like to export your finished photo with a more customized settings (including watermarks and 
other options), use ON1 HDR’s Export function (see “Export” on page 102) before pressing the Done 
button. You can also print your photos directly from within ON1 HDR 2023; see “Printing” on page 113 
for more. 
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ON1 HDR Edit Module Overview
Edit provides you with an easy-to-use workspace for editing your photos. Below is an overview of the main 
window sections of the Edit module:

A. Tool Well: Tools for working within the Edit module.

B. Preferences/Help: Shortcuts to app preferences and help; bottom icon opens and closes the 
Presets/Filters panel.

C. Preset panel: List of all installed presets (by category). When working in the Effects tab, a 
Filters panel is visible as well. 

D. Search: Searches presets (and filters, when working in Effects) by name.

E. Preview Window: Displays the current photo in detail view.

F. Preview option toggles: Magnification slider for current image, compare (before/after) mode, 
show/hide mask, turn soft proofing and preview on or off.

G. Tool Options bar: Options and settings for currently selected tool.

H. Photo Information pane: Navigator, levels (histogram) and general photo information.

I. Layers pane: Add, edit and manage layers here.

J. Edit tabs: Tabs for accessing Develop, Effects and Local Adjustments. Clicking on a tab brings 
up the settings for that tab.

K. Reset bar: Reset all (resets all Edit module settings), Reset (resets the current tab’s settings), 
Cancel (cancels all settings and returns to opening screen), Done (closes photo, opens a dialog 
box to let you specify the file name and type of the finished photo).
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L. Output: Shortcuts for printing, exporting and sharing the current photo. (Bottom icon opens 
and closes the right panel.

The left side of the window contains a Tool Well and a Presets pane (when using the Effects tab, you will 
also see a Filters tab alongside Presets).

The right side of the screen contains some photo informational panes at the top—Navigator, Levels/
Histogram, Info and a History pane—the Layers panel, and tabs for the three editing areas inside Edit: 
Develop, Effects, and Local. Clicking on a tab will bring up the options and settings for that area.  

ON1 HDR provides several ways to navigate and view your image in the Preview window:

• By default, your image is presented in Fit view, which displays the image within the preview 
area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will zoom in 
to 100%, and the cursor will change to the Hand tool. You can move around your image by 
clicking and dragging in the preview area. Clicking once will take you back to Fit view.

• You can also zoom in and out via the View menu and the Navigator pane. The Navigator pane 
displays a bounding box around the area currently on-screen, and you can reposition what is 
displayed in the preview area by clicking and dragging the box around the pane. Clicking on 
one of the buttons at the bottom of the Navigator pane will automatically zoom to Fit, 100%, 
50% or 25% views. (The buttons are visible in the Zoom tool’s Options bar.)

• When the preview zoom is larger than the viewable area, holding down the spacebar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
spacebar will reposition your image at the current view level.

ALTERNATIVE VIEW MODES

You have three options for viewing the photo in the current window:

• The default is a resizable, movable window.

• Full Screen Mode, which can be found in the Window menu, will expand the main window 
to fit the contents of the current display. The menu bar is hidden, but it can be viewed by 
moving the mouse cursor to the top of the screen. This mode can be toggled on and off by 
pressing Option-Control-F (Windows) or Command-Control-F (MacOS).

• Full Screen Preview, also found in the Window menu, will display the currently selected 
photo full-screen, without any of the other interface elements. This option is helpful when 
you wish to view a selection of photos as large as possible without any distractions.

Navigator, Levels, Info and History Panes
At the top of the control panel on the right of the main window are the Navigator, Histogram, Info and 
History panes. These tools can be useful for inspecting and viewing details of your image, as well as for 
looking at all of the Edit module adjustments made during a session.
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THE NAVIGATOR PANE

This gives you a thumbnail view of your image. The white square 
region marks the image area that is visible in the preview pane. You 
can pan your image by clicking and dragging inside the square.

At the bottom of the Navigator pane are several zoom buttons 
representing percentage zoom views (100%, 50% and 25%). Click 
on one of the buttons to change the view. Fit zooms to fit the 
current canvas size, while 100 zooms to 100%, displaying the 
actual pixels.

THE LEVELS PANE

This gives you a color chart of the shadow, midtone and highlight 
areas based on the image RGB values (commonly known as a 
histogram). This is useful to show areas within the image that may 
be clipping. Clipping is when your image contains pure blacks or 
white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the 
right represents the highlights. At the top of each end is a triangle. 
If the triangle is lit, there is clipping on that side of the histogram. 
If you click on the arrows, you will activate the clipping overlay on 
your image, which displays the areas that are clipped. Those areas with a blue overlay are pure black, while 
the areas with the red overlay are pure white. You can turn the clipping view off again by clicking on one 
of the triangles. You can also temporarily enable clipping view by holding down the J key at any time. The 
clipping view is useful when you are making adjusts to the brightness and contrast of your image. (See page 
64 for more information about using the clipping view.)

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

THE INFO PANE

The Info pane displays metadata for the current image in an easy-
to-read format. This metadata includes camera make and model; 
lens focal length; capture date and time; file type; ISO setting; 
shutter speed; aperture; and exposure compensation.

The Info pane also displays file-specific data, including name, and 
image dimensions. If any of the metadata fields are unavailable 
they will be left blank.

Settings Applied

At the bottom of the Info pane is a section that shows all of 
the operations from the Edit module that have been applied to 
the current image. Clicking on the right arrow to the left of the 
label will display a list of every tab in the Edit module, as well 
as primary adjustment options, including cropping, retouching and text operations. If an image has had 
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any adjustments made to it, that section of the Settings Applied area will be represented in white type, 
and you can use the arrows to the left of the label to drill down further into the Develop, Effects and 
Local Adjustment tabs to see which adjustments were made to an image. (On an image that has had no 
adjustments, all of the settings will be grayed out.)

Double-clicking on any of the available items inside the Settings Applied area will take you to that specific 
setting inside the Edit module, where you can make any desired changes.

THE HISTORY PANE

ON1 HDR 2023 has a robust Undo capability, which is helpful 
when you wish to back up a few steps during the editing process. 
When you want to go back further, it can be tedious to keep 
pressing Command/Control-Z. That’s where the history pane can 
be extremely useful. It displays every adjustment made during an 
editing session. From the History pane, you can scroll through your 
edits, all the way back to the state of your photo when you opened 
it for editing.

As you work, the History pane tracks all of your edits—even when 
working with layered files—adding each change you make to the top of the pane. History displays not only 
the adjustment, but in many cases will display the settings of sliders in the various panes and filters. 

You can scroll through the list, and, if you click on an item, HDR will “roll back” your edits to the spot you 
clicked. You can click up and down in the list, and, as long as you don’t make any changes, the entire Edit 
history is preserved. If you roll back to an edit and make a change, the History pane “resets” from that point 
on, losing any of the edits you made after the point you rolled back.

The History feature is designed to help you refine and understand the edits you made during an editing 
session; it not saved once you finish editing a photo.  

TIP: If you click on an item in the History pane, and you wish to step up or 
down in the adjustment history from that point, you can use the Undo/Redo 
commands to quickly go through the list. If you are happy with your edits, click 
back on the top item in the History pane to preserve the state of the photo.
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The Tool Well
The Edit module has 18 tools available for you when you are working on a photo, and are accessible via the 
Tool well on the left side of the screen. Some tools— Super Select AI, Transform (Move), Crop, and View—
are self-contained within the tool icons. Others are nested within a tool group—Local, Mask, Refine, and 
Fix—and are accessible via the Tool Options bar at the top of the screen when you click on one of those tool 
icons:

• Crop Tool: Trims an image to your desired size or ratio. Shortcut key: C

• Transform (Move) Tool: Moves and changes the size and rotation of your layer. 
Shortcut key: V

• Super Select AI Tool: Lets you select regions in an image by clicking on them and 
then applies Effects filters or local adjustments automatically to those regions. 
Shortcut key: K

• Adjustment Brush (Local group): Paints in or out local adjustments. Shortcut  
key: Shift+K

• Adjustable Gradient (Local group): Applies a selective gradient in local 
adjustment mode. Shortcut key: Option+K

• Masking Brush (Mask group): Mask large similar areas quickly. (Includes Perfect 
Brush option.) Shortcut key: B

• Masking Bug (Mask group): Applies a selective gradient as a mask in any filter (or 
to the entire stack). Shortcut key: M

• AI Quick Mask Tool (Mask group): Similar in operation to the Super Select AI 
tool, this tool generates masks by clicking on regions in a photo. Shortcut key: W

• Original Quick Mask Tool (Mask group): Create high-quality masks with only a 
few strokes as guidance. Shortcut key: Command-Option-Shift W (Mac); Control-alt-Shift 
W (Windows)

• Line Mask Tool (Mask group): Create masks using straight lines, with the 
capability to add curves and adjust mask points. Shortcut key: Shift-P

• Refine Brush (Refine group): Lets you refine an existing mask’s edges, to help 
mask difficult areas, such as hair. Shortcut key: N

• Chisel Tool (Refine group): Removes fringes from the edge of a mask. Shortcut 
key: Shift-H

• Blur Tool (Refine group): Blurs the edges of a masked area to help it blend more naturally. 
Shortcut key: L

• Healing Brush (Retouch group): Paint over a distraction and a matching area of your photo is 
magically blended on top to replace it. Shortcut key: Q 

• Perfect Eraser (Retouch group): Removes distractions like signs and power lines.  
Shortcut key: Shift-Q

• Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. (Includes 
Perfect Brush option.) Shortcut key: R

• Clone Stamp (Retouch group): Paints over an area from a sample of another area. Shortcut key: 
Shift-S
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• View Tool: Adjusts the magnification of the image in the Preview area, and lets you move 
around the Preview window. Shortcut key: Z

To access a tool, simply click on the tool, or use the shortcut key attached to the tool. When selected, the 
cursor will change, and you will see a set of options for the tool in the Tool Options bar above the Preview 
window. If the selected tool is part of a tool group, you will see the other tools in that group, on the left 
side of the Tool Options bar.

CROP TOOL

This tool lets you crop your image, and is fully non-destructive in the Edit module. The tool also 
has a content-aware option that lets you expand the photo canvas, filling the edges of a photo’s 
frame with realistic detail.

To crop an image without content-aware fill, select the Crop tool from the Tool Well, which will display the 
crop overlay. Select any preset crop ratio you would like to use from the Options bar — the default is 
Freeform, which lets you crop in whatever size or ratio you would like. Choosing a preset size (like 4x6) will 
display the crop overlay at that chosen aspect ratio.  

Adjust the corner handles of the crop overlay to get the area you wish. (The area outside the crop box 
appears darkened for guidance.) You can resize and move the image inside the crop box. When you are 
satisfied with your settings, press the Apply button in the Options bar or press Enter.

To move the image inside the crop box, simply click and drag inside the box. You can also nudge the image 
using the arrow keys on your keyboard. To resize the crop box, click and drag on any of the handles. 
Clicking on a corner handle allows you to adjust two sides at the same time; clicking on a side handle allows 

The Crop interface, with the Crop Preset pop-up open.
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you to adjust that side. If you hold the Shift key down while adjusting the size, the box’s proportions are 
maintained. To rotate the crop box, move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the 
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.

Crop overlays

When you select the Crop tool, HDR has the option to display guidelines 
as an overlay on top of your photo. These overlays can be used as 
compositional aids for cropping. HDR includes a number of overlays that 
you can display during a crop session, and they can be accessed from the 
overlay pop-up menu in the Tool Options bar when the Crop tool is active. 
There are seven options — Rule of Thirds, Grid, Diagonal, Triangles, Golden 
Ratio, Golden Spiral, and None — and you can easily go back and forth 
between them as desired while cropping. 

In addition to overlay type, there are two other sets of options in the pop-
up menu: 

• You can choose to have the overlay displayed all the time during a 
crop session, or to have HDR only display the overlay when your 
cursor is in the preview area of the workspace.

• When working with the Triangles or the Golden Spiral overlays, the Flip Overlay options will 
be visible, letting you flip the orientation of the overlays horizontally (Golden Spiral only) or 
vertically (Golden Spiral and Triangles).

Content-aware cropping

The content-aware feature lets you extend the 
crop beyond the edges of the frame. To use 
this, click the Content-Aware option in the Tool 
Options bar, and move the crop handle past the 
desired edge. When you click Apply, ON1 HDR 
will fill the expanded area with detail based on 
the content along the existing edge.

The Crop Overlay pop-up 
includes seven options for 
setting and displaying overlays.

When you select the Content-Aware option in the Tool Options bar, you can 
extend the canvas beyond the boundaries of the existing photo. Clicking Apply 
will fill the area based on the characteristics of the edges in the photo.
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Crop Tool Options Bar

• Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

• Preset pop-up: Lets you choose from Freeform, constrained or custom preset ratios.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotation tools: Rotates the photo 90° clockwise or counterclockwise.

• Reset: Resets the crop area to the size of your original photo.

• Cancel: Cancels the crop application and returns you to where you previously were in the 
Edit module.

• Apply: Applies the crop.

• Content-Aware: When clicked, will expand the canvas size, filling the edges of the photo with 
new detail, based on the area next to the expanded space.

Creating custom crop sizes

In addition to the preset crop 
ratios provided, you can create 
your own custom crop sizes. 
The bottom of the crop preset 
pop-up menu has a Custom 
submenu, which lists all of 
your custom ratios. To add a 
size, choose Manage Custom 
Sizes from the submenu. To 
add a new ratio, click the Add 
button, then enter a name, and 
the width and height ratio you 
wish to create (the units will always be “ratio” when you create a custom preset for the Crop tool). You can 
add as many as you’d like and click OK. The new crop ratios will appear in the Custom submenu.

TRANSFORM (MOVE) TOOL

The Transform tool is used to manipulate the contents of a layer, and works even if the only 
layer you have is the base photo layer. A layer may be repositioned, sized or rotated using the 
Transform Tool. When the tool is selected, handles will appear on the edges of the selected 
layer. You use these handles to manipulate the image. When you are done, click the Apply 

button in the Tool Options bar.

The bottom of the preset pop-up (above left) has a list of custom crop ratios that you can use in addition 
to the preset ratios. You can create your own presets via the Manage Custom Sizes submenu option, 
which opens the Custom Document Size Presets window (above right).
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The Transform tool is layer-dependent, and each document layer can have its own transform operations. It 
is useful when compositing photos, or applying backgrounds and textures in a multi-layered file.

Repositioning a Layer

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction.

Resizing a Layer

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center.

You can type in the size you desire in the Tool Options bar (see below) in the width and height fields. You 
can also size a layer to fill the canvas automatically by pressing the Fill button in the Options Bar.

Rotating a Layer

To rotate a layer, move the Transform Tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use the opt (alt) left 
and right arrow keys to rotate a layer when the transform tool is selected. To rotate the layer quickly in 90 
degree increments, you can use the rotate left and rotate right buttons in the Tool Options bar.

Flipping a Layer

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options bar.

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options bar or by pressing the Escape key.

Restoring a Layer After a Move

The Reset All command inside the Edit module will not reset transforms made with the Move tool. To reset 
your layer to its original, non-transformed state, click the Move tool and adjust any rotation you might have 
made, as well as any flip operations. Then choose the Fit to Canvas button. 

Transform Tool Options Bar

• Width: Changes the width of the layer, in pixels.

• Height: Changes the height of the layer, in pixels.

• Scale: Proportionally scales the layer, in percentage.

• Rotation: Rotates the layer, by degrees.
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• Rotate Left/Right buttons: Rotates the layer 90° clockwise or counterclockwise.

• Flip Horizontal/Vertical buttons: Flips the horizontal or vertical axis.

• Fill Canvas button: Scales the layer contents to fit the document size. 

SUPER SELECT AI TOOL

The Super Select AI 
tool is a specialized 
selection tool that 
lets you make a 

selection (or multiple selections) 
and automatically apply a local 
adjustment or any Effects filter to 
the selected area.

To use this tool, select it from 
the Tool Well and move your 
cursor over the photo. As you 
move around the photo, HDR will 
display the various regions in your 
photo as red overlays; clicking on 
a region will create a selection 
and change the overlay for that 
area from red to blue. If there are 
additional regions you wish to select, hover over the new area and click. To remove a selection, click on it a 
second time.

When you have completed your selection, choose an option from the Apply pop-up menu in the Tool 
Options bar. The menu includes a Local Adjustment option, as well as all of the filters found in the Effects 
tab. Each option in the Apply menu includes all of the styles for that local adjustment or filter. You can see 
the effects of each option in real time on your photo as you scroll over each of the items. When you’ve 
selected your editing option, click Add, and HDR will create that local adjustment or filter — in either the 
Local or Effects tabs — and apply the adjustment to the chosen selection. 

If you would like to add another filter or local adjustment to the photo, you can make a new selection and 
choose the effect you with to apply. Clicking Add will add that enhancement to the photo. When you are 
finished adding adjustments, click the Done button; the Super Select AI tool will be deselected, and HDR 
will choose the Zoom tool.

The Mode menu in the Super Select AI Tool Options bar has two options: Paint In or Paint Out. Paint In 
will apply the final adjustment to the selection you created with the tool, while Paint Out will apply the 
adjustment to the areas to the inverse of the selection (i.e. the areas that have not been selected).

While the masks created by the Super Select AI are generated automatically, they operate like any other 
mask created in HDR. This means you can use any of the other masking and mask-refinement tools to 
adjust and refine the finished masks. (See “Masking Basics” on page 50 for more.)

When you pick the Super Select AI tool and hover over a region in a photo, HDR will display that area 
in red. Clicking on the area will create the selection — changing the overlay from red to blue. From 
there, you can choose to add a local adjustment layer or any Effects filter from the Apply menu.
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Super Select AI Tool Options bar

• Apply: For choosing the local adjustment style (Local tab) or the Effects filter and style to be 
applied. 

• Mode: Sets the masking mode for selections when using the Super Select AI tool. Paint In 
means that the local adjustment or filter will be applied to the selection; Paint Out means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Feather: After you have added an adjustment or filter (by clicking on the Add button), this 
option will apply a feather to the edges of the selection.

• Add: Creates the adjustment layer or the Effects filter based on the current selection.

• Done: Quits the tool and selects the Zoom tool.

ADJUSTMENT BRUSH (LOCAL GROUP)

The Adjustment Brush, which works within the Local Adjustments tab, works like a standard 
brush tool, with adjustable sizes, feathering and opacity. You can paint an adjustment in or out 
via the Mode pop-up in the Tool Options bar, and adjust the size and feathering of the brush 
via the bar or with the bracket keys on your keyboard. The Adjustment Brush is especially 
powerful when used with the Perfect Brush option, represented by its icon at the right of the 

Tool Options bar.

The Perfect Brush option incorporates a color-based, self-masking technology to help create precise 
selections and masks. When you turn the Perfect Brush option on, the Adjustment Brush collects the colors 
under the center of the brush and applies the effect only to those colors. This protects the adjustment from 
being applied across edges. A great of example of using the Perfect Brush would be if you wanted to darken 
the sky in an image, but didn’t want to darken a group of mountains on the horizon.

The Threshold slider will allow you to control the balance between keep and drop colors, based on the area 
you are working on. For example you may want the Perfect Brush to be very precise and only paint away 
very similar colors, other times you want it to paint away a broad range of colors in the same neighborhood.

The Transition slider controls the feather of the Perfect Brush based on color. To create a soft edge, 
increase the transition. To create a harder edge you need to decrease the transition.

TIP: You can turn the Perfect Brush on and off using Command/Control-R 
(Mac/Windows). You can also temporarily lock the color to remove by holding 
down the Control key (Windows) or the Command key (Mac). This is useful 
when brushing through areas with a lot of openings like tree branches.
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Adjustment Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

• Use the Size pop-up in the Tool Options bar.

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Use your mouse’s scroll wheel (this option can be set in HDR 2023’s Preferences).

• Use your pressure-sensitive tablet.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys 
on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:

• Use the Opacity pop-up in the Tool Options bar.

• Press the Option (Mac) or Alt (Windows) key on your keyboard and press one of the 
number keys. Each number represents an opacity percentage from 10% (1) to 90% (9); 
0 represents no opacity.

• Use your pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.
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• Flow: This is the rate at which the brush color is applied, up to the Opacity setting. With a 
low flow number, as you brush back and forth across a stroke, the brush color will build up to 
the Opacity setting. At a flow of 100, the brush stroke color will be at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, round brush shape, this 
setting has no effect; it is more useful when working with custom brush shapes. You can also 
rotate the brush shape by pressing Shift-Option (Mac) or Shift-Control (Windows) and the left 
or right bracket keys (‘[‘ or ‘]’).

• Perfect Brush: The Perfect Brush incorporates an automatic edge-detection technology to 
help create precise selections and masks. When you turn the option on—by clicking on the 
Perfect Brush icon in the Options bar—the Masking Brush 
collects the colors under the center of the brush and applies the 
effect only to those colors. This protects the adjustment from 
being applied across edges, such as tree branches. 
 Further settings for the Perfect Brush can be found by clicking 
on the gear icon in the Tool Options bar. It has these options:

• Color Threshold: This option lets you control the balance 
between keep and drop colors, based on the area you 
are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar 
colors, while at other times you want it to paint away a 
broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect 
Brush based on color. To create a soft edge, increase 
the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: Sets the spacing of the brush tip as you apply a 
stroke. This is primarily used when painting with custom brushes. See page 93 for more. 

• Pressure options: HDR supports pressure-sensitive tablets. You can enable pressure sensitive 
controls for the brush size, brush opacity, or both simultaneously. To turn this support on, 
click on the gear icon in the Tool Options bar. You can activate pressure sensitivity for both 
size and opacity by clicking the appropriate buttons in the drop-down menu.

Detailed information on using Local Adjustments in ON1 HDR 2023 starts on page 89. There is also a 
short section, page 50, that includes best practices for using the different masking tools in HDR.

NOTE: The Adjustment Brush can also be used to apply custom brushes to an 
adjustment layer. See page 93.

Pressure-Sensitive Table Support

ON1 HDR supports pressure-sensitive tablets with the Adjustment Brush. When you use the Masking 
Brush you can enable pressure sensitive controls for the brush size, brush opacity, or both simultaneously. 
To turn this support on, click on the gear icon in the Tool Options bar. You can activate pressure sensitivity 
for both size and opacity by clicking the appropriate buttons in the drop-down menu.

Detailed information on using Local Adjustments in ON1 HDR 2023 starts on page 89.

Perfect Brush, spacing and tablet 
options can be found in the gear menu  
drop-down.
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ADJUSTABLE GRADIENT TOOL (LOCAL GROUP)

The Adjustable Gradient tool is very similar to the Masking Bug (see page 37), but it is solely 
for use within the Local Adjustments tab. It lets you create a linear or radial gradient mask 
across part of your image, The gradient mask goes from dark to light in tone, applying more of 
the adjustment where the gradient is lighter, and less of the adjustment where the gradient’s 

tone is dark. The most common use of gradient masks is to darken the sky in an image, while preserving the 
brightness of the foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Adjustable Gradient Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the Gradient Adjustment 
tool (top down, bottom up, left and right, and circular vignettes), and changes the current bug 
(if there is one) to match the preset.

• Shape: The shape pop-up controls the shape of the bug. In addition to the gradient options, 
there are two radial shapes: Center, which puts the light tones at the center and the dark 
tones on the outside, and Edges, which sets the gradient in the opposite direction.

• Opacity: Sets the maximum opacity or density of the mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes 
all gradients and clears any brushing that has been done.

Manipulating Gradient Masks

Once you’ve added a gradient to an image, you can modify it by 
accessing the parts of the gradient overlay:

• To move a gradient, click on the big circle at the center of the 
gradient and drag.

• To resize a radial gradient, click and drag on the solid line.

• To adjust the feather (hardness) of the mask, click and drag 
along the dashed line.

• To rotate the mask, click the smaller circle near the gradient 
center and drag.

Detailed information on using Local Adjustments in ON1 HDR 2023 starts on page 89.

The Edges gradient shape lets you create 
such masking effects as customized, 
adjustable vignettes.
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MASKING BRUSH (MASK GROUP)

The Masking Brush is one of two tools used for masking filters in Effects, as well as layer masks. 
When you select the Masking Brush, your cursor changes to look like two concentric circles, 
one representing the inner hard edge of the brush, and soft outer, feathered edge of the brush. 
At the center of the brush is either a plus or minus. The plus means that you are painting “in” a 
filter’s effect, while minus means the brush mode is set to paint out.

Masking Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

• Use the Size pop-up in the Tool Options bar.

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Use your mouse’s scroll wheel (this option can be set in HDR 2023’s Preferences).

• Use your  pressure-sensitive tablet.

• Feather: You control the amount of hardness of the brush by using the Feather pop-up. The 
feather has a range from 1 to 100 percent. Use a small feather at high magnification for 
precise, hard-edged work and a large, soft-edged brush in Fit to screen mode for general 
work. You can visually see your feather by watching the outer concentric circle of the brush 
tool. In addition to the Feather pop-up, you can adjust the size of the feather by holding 
down the Shift key and pressing the right or left bracket keys on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:

• Use the Opacity pop-up in the Tool Options bar.

• Press the Option (Mac) or Alt (Windows) key and press a number key. Each number (1-
9) represents an opacity percentage from 10% to 90% ; 0 represents no opacity.

• Use your  pressure-sensitive tablet.
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TIP: Think of the opacity as the shade of gray you are painting onto your mask. 
While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.

• Flow: The rate at which the brush color is applied, up to the 
Opacity setting. With a low flow number, as you brush back and 
forth across a stroke, the brush color will build up to the Opacity 
setting. At a flow of 100, the brush stroke color will be at the 
Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the 
default, round brush shape, this setting has no effect; it is more 
useful when working with custom brush shapes. You can also 
rotate the brush shape by pressing Shift-Option (Mac) or Shift-
Control (Windows) and the left or right bracket keys (‘[‘ or ‘]’).

• Perfect Brush: The Perfect Brush incorporates an automatic 
edge-detection technology to help create precise selections and 
masks. When you turn the option on—by clicking on the Perfect 
Brush icon in the Options bar—the Masking Brush collects the 
colors under the center of the brush and applies the effect only 
to those colors. This protects the adjustment from being applied 
across edges, such as tree branches. 
 
Further settings for the Perfect Brush can be found by clicking on the gear icon in the Tool 
Options bar. It has these options:

• Color Threshold: This option lets you control the balance between keep and drop 
colors, based on the area you are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar colors, while at other times 
you want it to paint away a broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect Brush based on color. To 
create a soft edge, increase the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: When checked, this sets the spacing of the brush tip as you apply a stroke. 
This is primarily used when painting with custom brushes. See page 93 for more. 

• Pressure options: HDR supports pressure-sensitive tablets from  with the Masking Brush. 
You can enable pressure sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You 
can activate pressure sensitivity for both size and opacity by clicking the appropriate buttons 
in the drop-down menu.

Detailed information on using Local Adjustments in ON1 HDR 2023 starts on page 89. There is also 
“Masking Basics” on page 50, which includes best practices for using the different masking tools.

Perfect Brush, spacing and tablet 
options can be found in the gear menu  
drop-down.
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NOTE: The Adjustment Brush can also be used to apply custom brushes to an 
adjustment layer. See page 93.

Pressure-Sensitive Tablet Support

ON1 HDR supports pressure-sensitive tablets from Wacom and others with the Adjustment Brush. When 
you use the Masking Brush you can enable pressure sensitive controls for the brush size, brush opacity, or 
both simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You can activate 
pressure sensitivity for both size and opacity by clicking the appropriate buttons in the drop-down menu.

Detailed information on using Local Adjustments in ON1 HDR 2023 starts on page 89.

MASKING BUG (MASK GROUP)

The Masking Bug is used for blending layers 
by creating radial, gradient and reflected 
gradient mask shapes quickly. It works in a 
similar manner to the Adjustable Gradient 

tool in the Local Adjustments pane. The mask goes from 
dark to light in tone, applying more of the adjustment 
where the gradient is lighter, and less of the adjustment 
where the gradient’s tone is dark. The most common 
use of gradient masks is to darken the sky in an image, 
while preserving the brightness of the foreground, 
similar to using a gradient filter on your camera lens.

To apply a standard gradient to a filter, click on the Masking Bug in the Tool well, then click in the image 
roughly where you wish the gradient to go. You’ll see the outline of the gradient, which is called a bug. 
You can use the handles on the bug to move your gradient around, increase or decrease the length of the 
gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Masking Bug Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the tool (linear top down, 
linear bottom up, left and right, and circular vignettes), and changes the current bug (if there 
is one) to match the preset.

• Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial shapes: Center, which puts the light tones at 
the center and the dark tones on the outside of the mask, and Edges, which sets the gradient 
in the opposite direction.

In this image, a Dynamic Contrast filter has been applied in Effects. 
To keep the effect out of the clouds, a Masking Bug has been added.
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• Opacity: Sets the maximum opacity or density of the mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a Gradient Mask

Once you’ve added a gradient to an image, you can modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle at 
the center of the gradient and drag.

• To resize a radial gradient, click and drag on the 
solid line.

• To adjust the feather (or hardness) of the mask, 
click and drag along the dashed line.

• To rotate the mask, click on the smaller circle 
near the center of the gradient and drag.

TIP: To see the mask created by the Masking Bug, and the range of black to 
white tonality, choose Show Mask from the View menu. You can choose either 
a red overlay, which presents the mask over your image, or grayscale, which just 
shows the mask as black to white tones.

Working with Multiple Masking Bugs

You can have up to six Masking Bugs per layer. To add another Masking Bug, press the Add button or click 
outside of the current bug while the Masking Bug tool is selected.

Only one Masking Bug may be adjusted at a time. You will see the overlay controls for the active bug while 
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug 
clicking on this small circle marker.

Masking Bugs are subtractive. Each bug hides more and more of the current layer. When Masking Bugs 
overlay each other they may hide more of the layer too. You can always use the Masking Brush to override 
and paint areas back in hidden by the Masking Bugs.

AI QUICK MASK TOOL (MASK GROUP)

The AI Quick Mask tool is functionally similar to the Super Select AI tool, but it is intended to 
create selections for the current filter, local adjustment, or layer — all it does it create a mask 
for that item. It does not create a new filter pane or local adjustment layer.

To use the Quick Mask tool, first create a filter in Effects, a local adjustment layer in the Local Tab, or 
the master layer mask, select the tool, and move your cursor over the photo. As you move around the 
photo, HDR will display the various regions in your photo as red overlays; clicking on a region will create a 
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selection and change the overlay for that area from red to blue. If there are additional regions you wish to 
select, hover over the new area and click. To remove a selection, click on it a second time.

The Mode menu in the AI Quick Mask Options bar has two options: Paint In or Paint Out. Paint In will apply 
the final adjustment to the selection you created with the tool, while Paint Out will apply the adjustment to 
the areas to the inverse of 
the selection (i.e. the 
areas that have not been 
selected).

While the masks created 
by the Quick Mask 
tool are generated 
automatically, they 
function like any other 
mask created in HDR. 
This means you can use 
the other masking tools 
to adjust and refine the 
finished masks. This 
also includes the Mask 
Control options found 
in all Effects filters, 
local adjustments, and 
in the layer masks. (see 
“Masking Basics” on 
page 50 and “Masking 
control options” on page 
52.)

AI Quick Mask Tool Options bar

• Mode: Sets the masking mode for selections. Paint In means that the local adjustment or 
filter will be applied to the selection; Paint Out means that the adjustment or filter will be 
applied to all areas in a photo except for the selection.

• Cancel: Cancels the operation, deselecting the tool and selecting the Zoom tool.

• Done: Creates the mask for the current filter, adjustment or layer and selects the Refine 
brush.

Use the AI Quick Mask tool instead of the Super Select AI tool when you wish to create an AI-generated mask, 
but already have an existing Effects filter or local adjustment layer, or when you want to add a mask to the 
current layer in your document.
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ORIGINAL QUICK MASK TOOL (MASK GROUP)

The Original Quick Mask tool (formerly known as the 
AI Quick Mask tool in previous versions of ON1 HDR) 
can create high-quality masks with just a few strokes as 
guidance. To use it, just mark areas you want to keep in 

green and areas you want to drop in red. When you click Apply, the 
Original Quick Mask tool analyses the color, tone and texture of 
the marked regions to learn what you want to make out and then 
automatically finds the edges and creates the mask for you.  

Here are the steps you need to follow to use the Original Quick Mask Tool:

1. First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode —which is the default brushing mode—over the portions of your image that 

you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 
Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green.

2. Now press the Apply button in either the Tool Options bar or the Original Quick Mask HUD. 
This will generate a temporary mask to preview the results. Areas that are filled with red will 
be masked out, areas in green will remain. Keep in mind the edges will appear rough at this 
point and will be smoothed out when you generate the final mask.

3. If the preview results look good, press the Done button in the Tool Options bar or the 
Original Quick Mask HUD. If there are areas that are incorrect, you can continue to improve 
the results by adding more Keep and Drop strokes. Press Apply each time to preview the 
improved results. When you press Done, the edges are refined with high precision and ON1 

When you first open the AI Quick Mask tool, you’ll 
see  a window—called the HUD—that includes 
instructions for using the tool.
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HDR switches to the Refine Mask tool, which you can use over difficult, semi-transparent 
areas—like tree branches—if necessary.

NOTE: The Original Quick Mask tool resets existing masks on a layer or filter.

Original Quick Mask Tool Options Bar 

• Mode: This controls keeping (painting green) or dropping (painting red). Green areas are 
protected in your mask, and are the areas of a layer or filter that will remain. The areas 
marked in red will be removed or masked. In your layer these areas will become transparent. 
On a filter in Effects, these areas will have the filter’s effect removed.  
 You can tell your current mode by looking at the plus or minus icon in the center of the 
Original Quick Mask brush. If the icon is minus, you are painting drop (red) areas; if the icon is 
a plus, you are painting keep (green) areas. You can change the mode in the Tool Options bar, 
or by pressing the Shift-X key, or by holding down the Option (Alt) key temporarily. 

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways: 

• Use the Size pop-up in the Tool Options bar. 

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ . 

• Use your mouse’s scroll wheel (this option can be set in HDR’s Preferences). 

• Use your pressure-sensitive tablet. 
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Further settings for the Original Quick Mask tool can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options (shown below): 

• Pressure Adjusts Size: This option lets you control 
the size of the brush using a pressure sensitive tablet. 
The harder you press, the larger the brush becomes 
up to the current setting of the size slider.  

• Refine Edge: This applies the Refine Mask Brush 
automatically to the edge of the resulting mask, 
creating a more natural transition. This is on by 
default and recommended for most photos.

• Show HUD: This displays the Original Quick Mask 
HUD dialog (shown on page 40), which provides 
guidance on how to use the tool.

• Overlay: Sets the transparency of the red and green mask overlays on top of your image. A 
setting of 100 displays only the mask; the default setting is 50.

LINE MASK TOOL (MASK GROUP)

The Line Mask tool lets you create masks by 
drawing straight lines in your image, with the 
added flexibility of letting you adjust each 
individual line segment into curves to better 

fit the object you want to mask. Masks created with this 
tool are re-editable, can be copied and pasted like any 
other mask inside Effects, and you can have multiple Line 
Mask selections for each mask. 

To start, you click and drag along the outline of the area 
you wish to mask. Clicking your mouse button (or with a 
pen and tablet) adds a point to the line; you can continue 
to click along the edges of your desired selection, and 
the tool will add points along the way. These points will 
be represented by a small square. When you’re finished, 
hover your cursor over the first point and click on it to 
close the path created by the tool. This will close the 
selection and change the cursor to a paint bucket icon; click inside the area and Effects will create and the 
display the mask. 

Once you’ve closed the mask, you can adjust the feather and opacity of the mask, and you can further 
adjust the points on the line in the following ways:

• You can click on any point in the selection and move it by dragging it.

• If you hover (or click) on a point, you’ll see a circle appear between that point and the 
previous point on the line. This circle can be dragged in all directions to curve the line to 
better fit the object you are masking.

• Add a point by holding down the Shift key and clicking on the line.

• You can delete any point by right-clicking on it and choosing Delete Point from the pop-up. 

When you complete the mask area by clicking on the original 
point, the cursor will change to a paint bucket icon. Clicking in the 
area will generate the mask, and let you adjust any of the points, 
or add curves for further refinement of the mask edge..
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• You can delete the entire mask by choosing Delete Line Mask from the pop-up menu.

While you’re creating the mask, the curve option is always available for the current point; move the cursor 
back over the line before the point and the circle will appear. You can then drag the curve in or out, and 
when you’re done, move the cursor and click on the next place you wish to add a point.

When you’ve made your adjustments to the selection, 
you can click the Done button in the Tool Options bar to 
quit the tool, or you can create another mask. 

To re-edit the mask at a later time, select the filter, layer, 
or adjustment layer that has the mask attached to it and 
choose the Line Mask tool. When you move your cursor 
over the area that contains the mask, the mask’s outline 
will appear in light blue. Click anywhere on the outline, 
and the mask’s points — both square and circle — will 
appear, and you can adjust it as you see fit, even the 
Opacity and Feather settings.

Line Mask Tool Options Bar

• Mode: The mode controls if you are painting out (hiding the effect inside the mask 
boundaries) or painting in (showing the effect).

• Opacity: This controls the opacity, or transparency of the finished mask, from 1 to 100 
percent. At 100 percent, all of the effect will be displayed in the mask area; as the opacity 
level drops, more of the layer underneath the mask will be visible.

• Feather: Controls the hardness of the mask edge. The feather has a range from 1 to 100; 
1 being a hard edge across the boundaries of the mask, 100 being a soft, wide edge that 
‘feathers’ the transition between the masked and unmasked boundaries. 

• Delete: Removes the currently selected line mask.

• Done: Saves the current line masks ad closes the tool, returning Effects to the View Tool.

The curve option—visible when you hover over a point in the 
selection—lets you fine tune the line to make it better fit the 
object you’re masking. (Shown here exaggerated for effect.) 
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REFINE BRUSH (REFINE GROUP)

This tool cleans up intricate areas and the borders along a mask, and is helpful for cleaning up 
a mask created with the Masking Brush. For example, when you wish to apply an effect to a 
subject, and there are areas such as hair, or tree branches that are difficult to remove with the 
Masking Brush.

To use the Refine Brush, select the tool in the Options bar and paint along the edges where you would like 
the mask to be refined. The brush strokes are displayed as a red overlay, and when you let up off the mouse 
button, HDR will work to make making the mask edge more defined, improving the overall mask.

Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which always refines to remove from 
the mask, Paint In, which always refines to add to the mask, or Auto, which does both at the 
same time. Paint Out is recommended in most cases.

• Size: This slider adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results.

• Pressure Adjusts Size (gear icon): If you have a pressure-sensitive tablet you can control the 
size of the brush with pressure when this setting is turned on.

CHISEL MASK TOOL (REFINE GROUP)

The Chisel tool, accessible vie the Refine Tool Options, bar works to remove fringes or halos 
along the hard edges of a mask; just click and drag along the edges of a mask you wish to refine. 
Fringes are common when the background to be removed is brighter than the foreground. The 
chisel works like a chisel or plane in a wood shop: It removes just a sliver along the edges, and, 

because it only works on the edges, you don’t have to be too careful when using it.

Chisel Mask Tool Options

• Mode: Select remove or add

• Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
The size of the chisel does not affect how much is chiseled off.

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-click on the Chisel tool icon to apply the chisel to the entire mask.
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BLUR MASK TOOL (REFINE GROUP)

The Blur Mask tool softens edges of the mask where you paint; all you need to do is run the tool 
over the edges you wish to blur. Softening the edges on blurred or semi-transparent subjects like 
hair can make them blend with a new background in a more realistic manner. 

Blur Mask Tool Options

• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 
and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

• Size: Adjusts the tool size. Use a large size to make brushing fast; size doesn’t affect blur 
amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking on the Blur tool icon applies the blur to the entire mask.

HEALING BRUSH (RETOUCH GROUP)

The Healing Brush is 
a tool for removing 
distractions like 
dust spots, power 

lines and unwanted people 
from your photos, using 
sophisticated content-aware 
fill technology. Like the other 
retouching tools, you can apply 
the brush to multiple portions 
of an image. Unlike the other 
tools, however, the Healing 
Brush is fully non-destructive: 
each area you apply the brush 
to is individually editable (and 
removable).

To use the brush, paint over 
a distraction and a matching 
area of your photo will be 
blended on top to replace it, using content-aware technology. You’ll see two circular markers: red, which is 
the area that has been removed, and green, which is the area that was used to fill the source. Each marker 
is movable by clicking and dragging; sometimes, you’ll want to try a different area to match to your source. 

Areas that use the Healing Brush will be displayed as a gray marker. Clicking on a specific marker will let 
you readjust its placement or delete it.
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Non-active markers will be displayed as gray squares until you click on them. (Press the Delete key to 
remove the current area.)

The Healing Brush has four modes, Heal, Stamp, Copy and Move. Each mode has a different approach:

• Heal mode applies content-aware matching from a nearby area to mask the object or area 
being painted out.  

• Stamp mode acts like the Clone Stamp tool (see page 107), applying the actual pixels from 
the area used to mask the object out; unlike that tool, however, this option is non-destructive.

• Copy mode is similar to the Heal mode, except that it makes a copy of the brushed area or 
object instead of masking it out.

• Move mode is similar to Copy mode, except that it masks the brushed area and moves the 
original area to a new location.

Healing Brush modes cannot be changed once they have been applied; if you wish to change the 
application in an area, you must select the old marker, choose Delete from the Tool Options bar, set the 
new mode, and re-brush the chosen area. 

Healing Brush Options

• Brush Size: Adjusts the overall size of the brush.

• Brush Feather: Adjusts the hardness of the brush. 

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften it.

• Mode: sets the type of healing that will be applied when brushing — Heal (content-aware), 
Stamp (pixel-exact), Copy (content-aware) or Move (content-aware).

• Overlay: Sets the display of the markers designating retouched areas. Auto displays all the 
markers in the photo, with the current marker highlighted in red and green, and the others as 
gray. Selected will only display the current marker (in red and green); the other markers will 
only be visible as you move over the photo with your mouse.

• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots 
more easily.

• Pressure Adjusts Size (gear icon): If you have a pressure-sensitive tablet, you can adjust the 
size of the brush according to the pressure. Click the button to activate.

TRANSFORMING RETOUCHED AREAS

As noted, all applications of the Healing Brush are non-destructive, meaning that you can adjust the source 
and destination areas for each marker, and you can delete markers by clicking on the appropriate market 
and choosing Delete from the Tool Options bar (or by pressing the Delete key).

You can also transform individual destination markers in a photo by holding down the Option/Alt key (Mac/
Windows) and hovering over the area. When you do this, a box will appear over the currently selected 
destination marker. You can resize the selection by adjusting the handles on the box; to resize 
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proportionally, hold down the Shift key. You can also rotate the selection by clicking outside the box and 
pressing the mouse key, or you can flip the selected area vertically or horizontally by clicking the icons 
underneath the box.

PERFECT ERASER (RETOUCH GROUP)

The Perfect Eraser can be used to remove distracting elements and blemishes from your image. 
It uses a content-aware algorithm that replaces the pixels with a natural-looking result within the 
boundaries that are painted.

Using the tool is easy: paint over the area you wish to remove and release the mouse, covering the entire 
area. A red overlay appears where you paint. If the first attempt does not give you a perfect result, paint 
over it again. You can also fine tune the area after applying the tool by using the Retouch Brush (see below).

Perfect Eraser Options

The Perfect Eraser’s Tool Options bar consists of two options; brush size, and pressure-sensitive tablet 
support The default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller 
by clicking on the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your 
keyboard. The maximum brush size is 500 pixels. If you have a pressure-sensitive tablet, select the Pressure 
Adjusts Size button in the Options bar.

When you hold down the Option or Alt key and hover over the currently selected Healing Brush marker, a box appears, which lets you 
adjust the size, rotation and orientation of the marker. When used in conjunction with the Healing Brush’s Copy or Move modes, you 
can easily duplicate and transform individual subjects within your frame, as shown by the copy of the pronghorn above..
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RETOUCH BRUSH (RETOUCH GROUP)

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the brush 
on areas that contain spots or other imperfections, such as acne, sensor dust, power lines and 
more. The tool looks at the neighboring areas in your image and fills in the brushed area with an 
area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the Retouch Brush and don’t like the results, use the Undo command and try using 
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: Click on the button to activate the pressure-sensitivity controls.

CLONE STAMP (RETOUCH GROUP)

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. Hold 
down Option (Mac) or Alt (Windows) and click the area you want to clone from. Then click and 
drag on the area you want to clone over and it will clone from the point you selected.

Clone Stamp Tool Options:

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: If you have a pressure-sensitive tablet, you can adjust the size of the 
brush according to the pressure. Click the button to activate.
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VIEW (ZOOM) TOOL

This tool, which is the default tool selected when you open an image in the Edit module, 
adjusts the magnification of the image in the Preview window. With the Zoom tool selected, 
click in the Preview window to zoom in and center the image at the location clicked. Hold 
down the Option/Alt key to display the Hand tool, which lets you pan around the magnified 

image. You can also double-click the Zoom tool in the Tool well to set the image to 1:1 (or 100%) 
magnification view, which shows every pixel. This is best when examining small details.
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Masking Basics
One of ON1 HDR 2023’s most powerful features is its 
masking capabilities. Every filter in Effects, every adjustment 
panel in the Local tab, and every layer can have a mask 
associated with it.

At its simplest level, a mask shows or hides the effect of the 
filter or adjustment. Masks have no color: they are grayscale, 
and their tones range from pure white to pure black. A mask 
that is completely white displays the entirety of the effect 
being used, a mask that is completely black hides that effect. 
(A common way to remember it is via the phrase “black 
conceals, white reveals.”) Shades of gray are in effect the 
opacity of the mask. Darker shades reduce the effect, lighter 
shades let more of it through.

The beauty of the masks is that you can paint with black, 
white or any shade in between, so you can “mask” portions of 
your photo so that they will not have that effect—or will have 
a reduced effect. You can also copy masks from one filter and 
past them into other filters. Using this feature, you can mask 
out the sky in one filter, copy the mask, paste it into another 
filter and invert it, applying a different effect to everything 
but the sky. HDR even lets you create luminosity masks, which 
are masks that are solely based on the brightness of the pixels 
in the image. You can view your masks, either as a red overlay 
or as the grayscale version of the actual mask, which can be 
helpful when you wish to look at the edges of mask.

Creating masks can be as simple as choosing the Super Select 
AI tool and clicking on a region in a photo; adding an Effects 
filter or local adjustment and using the Mask AI options; 
using the Masking Brush with the Perfect Brush option on; or 
placing an adjustable gradient. You can also use multiple tools 
and masking functions to create more complex masks. For 
instance, you can drop a gradient on a photo, use the Masking 
Brush to paint in places where don’t want the gradient 
applied, or you can use the Color Range tools (found in the 
Masking Control Options area) to select portions of an image 
based on color. 

THE MASKING TOOLS AND VIEW OPTIONS

Inside ON1 HDR 2023, there are six basic tools used to create masks: the Masking Brush, the Masking Bug, 
and the Super Select AI, AI Quick Mask, Original Quick Mask, and the Line Mask tools. There are variants of 
the first two that are specific to Local Adjustments (Adjustable Brush and Adjustable Gradient).

Three views of a mask (A-C), along with the 
Masking Control Options section, here shown 
attached to a HDR Look filter in Effects. When you 
first add a filter (or a layer), the mask is empty (A). If 
you click on the empty mask, HDR will 
automatically generate the mask, here shown filled 
with white, which means all of the effect will come 
through (B). When you use any of the masking 
tools, the areas masked out (partially or 
completely), will be shown in the filter’s mask view 
(C). And, whenever you click on the mask icon in 
the pane, it includes options for displaying, copying 
and pasting, and fine tuning that mask (D)
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You can use the gradient and masking brush tools cumulatively, meaning that you can add to or subtract 
from the current mask. However, if you select the AI Quick Mask tool or the Original Quick Mask, it will 
replace any existing masks on that pane or layer.

The Refine group of tools—Blur, Chisel and Refine—are designed to help work with edges and halos that can 
crop up when you have areas of strong contrast between a masked area and an unmasked one.

In addition to the masking tools, each mask has a set of controls you can use to manipulate the mask to 
refine it further. 

When you add a filter 
or a layer, the mask is 
technically hidden. You 
can create a mask by 
either using one of the 
masking tools, or by 
clicking the Show/Hide 
Mask icon in the title 
bar of the pane, to the 
right of the filter name. 
The contents of the 
Show Mask icon will 
represent the mask on 
that layer. (Local 
Adjustment panes 
automatically create a 
black layer mask, so you 
can ‘paint in’ the 
adjustment to the 
image.)

There are two primary options for viewing the contents of a mask: either as a red overlay on top of your 
image (the default) or a view only of the mask itself, represented as grayscale. The grayscale view can be 
helpful when checking edges, or when refining some of the advanced masking controls. These mask view 
options are available from the Mask menu; select Show Mask to see the mask, while the View Mode option 

Here is a local adjustment—using the Adjustable Gradient tool—that has been applied to a photo to hide the HDR 
Look filter’s effect on the sky. The Show Mask option has been turned on (red), so you can see where the effect has 
been masked out. 

The two Mask View options help in different ways. The Red Overlay option (above left) can give you an idea of what portions of your photo are successfully 
masked in or out. The Grayscale option (above right) lets you view the mask solely as luminance values, where pure black indicates portions that have been masked 
out completely, pure white is where the effect is applied completely, and the levels of gray indicate partial application of the effect. The Grayscale option is 
especially useful when you wish to check the edges along a mask border.
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lets you switch between the two modes. You can also set the app to display the red overlay when you are 
brushing with the Masking Brush and its cousins. (HDR will remember the previous settings.)

When you’re viewing a mask in either overlay or grayscale modes, you have access to all of the tools in the 
Edit module. You can zoom in, to view the mask in greater detail, you can use the Refine masking tools to 
adjust the fine edges of your mask, or you can use any of the other the masking options described below.

MASKING CONTROL OPTIONS

When you click on the Mask icon at the top of a pane 
or in a layer, HDR will display a set of options for that 
mask. This section has the following contents, as 
shown, using the Color Enhancer filter as an example:

A. The Show/Hide Mask icon, which displays 
the contents of the current mask. The default 
mask is white when you add an effect, and 
black when you add a local adjustment layer.

B. Buttons for opening the blending options, 
resetting the filter, and removing the filter.

C. Sets the overall opacity of the effect.

D. Mask AI pop-up (Effects and Local tabs only) 
for selecting an area based on region.

E. Larger display of the current mask, option to 
invert, reset, copy, paste, create a luminosity 
mask, and view/hide the mask.

F. Density adjusts the overall density from black 
(100) to white (0). Feather blurs the mask. 
Levels and Window let you adjust the black 
and white points of the mask, fine tuning 
them in different ways.

G. The Color Range option lets you choose a 
color and make or tune the mask based on 
the range of the color selected.

The buttons at the top portion of the Mask Options can 
be quite helpful, especially when you’re working with 
complex masks, or when you wish to reuse masks in other parts of HDR. There functions are as follows:

• Invert reverses the contents of the mask, swapping the tones.

• The Reset button erases the current mask, leaving it filled with white. 

• The Copy and Paste buttons let you copy the current mask, to paste it into another filter, 
local adjustment or layer. 

• The View button toggles the Mask View on and off.

• The Lumen button creates a luminosity mask of the image for the current filter, adjustment or 
layer, replacing any existing masks (see page 53). 

Overview of the Mask Options section, shown with a Color 
Enhancer filter. The Mask AI pop-up is displayed beneath the 
options. Mask Options is also applicable when working in the 
Local Adjustments tab, or on a layer in the Layers pane.
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Color Range selections

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 
slider to expand or contract your mask based on that color: lower numbers means that fewer colors (related 
to the chosen color) will be selected, higher numbers mean a wider range of will be selected.

The Color Range option found in the Gradient masking tools can be controlled from the Mask Options 
section of the pane. When you add a gradient mask and click on the Color Range option in the Tool Options 
bar, the color chosen is sampled from the center of the gradient control, but you can open the Mask 
Options pane and sample a different color using the eyedropper. Note that if you do this, and move the 
masking bug, it will resample using the color from the center of the bug.

Luminosity masks

A luminosity mask is a specialized mask type you can create anywhere you can create a mask inside HDR. 
This mask uses the brightness (or luminance) values in your image to let you target specific tonal ranges 
with an effect (or to hide the effect from those tones). It is ideal for subtle enhancements to very specific 
areas of an image. They can be used for targeted sharpening and contrast operations, highlights control, 
and much more.

To add one of these masks, click on the Lumen button in the Mask options area or choose Create 
Luminosity Mask from the Mask menu. Because luminosity masks take the brightness levels of a photo, 
when you view the mask, it will look like a grayscale version of the image. With a luminosity mask, your 
effect will be applied in an increasing amount depending upon the brightness value of the pixel underneath: 

Here, we’ve created a mask using the Color Range option in the Mask Options section for this local adjustments layer. We clicked on a 
blue color in the sky to use as the base for the selection range. Adjusting the Color Range slider while viewing the mask lets us fine tune 
the selection without using brushes or gradient masks. We can then further refine the mask using other masking tools or the refine mask 
tools.
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if the pixel is black, none of the effect will be applied; if it is white, it will be entirely applied; for all other 
tones, the effect will get applied as a percentage of the pixel’s brightness, from 0 (white) to 100 (black).

You can use the Levels or Window controls to further target tones with your luminosity mask. The Levels 
setting lets you set the black (left triangle) and white (right) points of the mask, with the midpoint, or 
gamma, setting being adjusted by the middle triangle. This lets you refine the mask to focus on narrow 
bands of luminance values in an image; for example, if you wanted to focus an effect on the midtones, 
bringing the white and black points into the middle of the Levels slider, and adjusting the midpoint, will 
achieve this much quicker than you could with the Masking Brush.

The Window slider is similar to the Levels slider, in that it works like a black point slider from both sides. 
When you move the right and left triangles, all of the tonal ranges outside the points will be black, leaving 
those areas affected that are within the ‘window’ of the mask. For example, if you wanted only the shadows 
in your image to have an effect, you would move the right slider over towards the left by about two-thirds.

MASKING TIPS

Here are a few tips for working with the various options in the Mask pane:

• You can use multiple masking tools to create, modify and refine masks. For example, you can 
start with a luminosity mask, adjust the tonal range of the mask with the Levels or Window 
sliders, and then further refine your mask by painting in or out with the Masking Brush or 
Masking Bug. Adding a luminosity mask always overrides the current mask (as is the case with 
the AI Quick Mask tool), however, so you should start there.

• While the AI-based masking tools can be quite good when building selections, they aren’t 
perfect. You should inspect your AI masks after applying them, and use the other masking 
tools, the refine mask tools or Mask Options to fine-tune your selections.

• Use the Feather slider to smooth transitions between masked and unmasked sections.

• Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it 

Viewing a luminosity mask is similar to a black-and-white version of your photo; the lighter the tones, the more the intended 
effect will be, and the darker the tones, the lower the effect. You can use the Invert button to swap the tones in a luminosity 
mask, or use the Levels and Window controls to restrict the mask to specific tones in your selection.
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like a ‘reverse fade’: at the 100, all of your mask is viewable, at 0, the mask is entirely white.

• Don’t forget that masks aren’t just for Effects filters and Local Adjustments; you can create 
a master layer mask that will apply your selection to the cumulative adjustments made in the 
Edit module. To do this, click on the Mask icon to the right of the layer.

• It can sometimes be helpful to use the same mask on different filters, so use the Copy button 
to grab the contents of a mask from one filter and the Paste button to paste that onto the 
mask of another filter. The Invert command can be invaluable when you wish to apply a filter 
to the opposite portion of a photo, such as a sky and your foreground.

• Because masks are tied to the actual pixels of the current photo (or layer), they cannot be 
copied from one photo to another, or between layers in a multi-layered document.
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Presets
Presets are stored “recipes” that include sets of Develop settings, Effects filters and local adjustments, 
and can be applied to a photo with one click. Presets are a fast way to get consistent results when editing 
a group of images, helping you hone your own look. You can also create your own presets, even presets 
that incorporate ON1 HDR’s Mask AI technology to apply masks automatically to regions in a photo (See 
“Creating and Using AI Adaptive Presets” on page 58).

ON1 HDR 2023 comes with more than 50 built-in presets, in seven categories, ranging from landscapes to 
black and white and much more. You can create your own presets, or import presets from other ON1 users 
and photographers.

You can create presets that apply Develop adjustments, Effects settings, and local adjustments that use the 
Adjustable Gradient tool, and any combination of these.

Presets can also store crop settings and retouching information, as well as masks created with brush tools, 
Effects’ Masking Bug, and the Adjustable Gradient Tool in the Local Adjustments panel. If you apply a 
preset that contains these options, you should check to make sure that you have the desired result; if not, 
you can reset the various individual operations via the Settings menu. 

Three different views of the Preset panel. On the left is the List view, in the center is Thumbnail view; these views display the categories of 
presets. (The view options can be set in the View > Preset Browser submenu.) On the far right is an expanded category, displaying the various 
presets, with a thumbnail of the current image with the preset applied. From there, you can apply a preset to the current image.

As you hover over a category, the Quick View Browser icon appears on the left side of the category’s name.(Landscape is shown above in the 
preset category list.) Clicking on that icon will open a full-screen window showing your photo with that category’s presets applied to it. (See 
the following page for a screen shot of the Quick View Browser.

HDR lets you create your own custom presets and categories, and you can also create subcategories of presets. (See page 9 for more.)
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APPLYING PRESETS

To apply a preset to an image, click on the Presets panel. There you will see any built-in presets supplied by 
ON1—ordered by category—as well as any presets you might have created or installed yourself. Clicking on 
a category name will open it and display any presets within that category, with a tiny thumbnail showing 
your selected image with that preset applied to it. To change the size of the thumbnails in the Presets panel, 
select the Browser Mode option from the View menu and choose One, Two or Three Column View.

To help you view the effects of a specific preset, HDR will display a real-time representation of that preset 
over your current photo when you hover your cursor over a preset in the subcategory view. To see a larger 
representation of what your selected photo will look like with all of 
a category’s presets, click on the Quick View Browser icon in the 
category’s title bar. That will display a window with all of the 
presets in that category. (Press the Escape key to close the Quick 
View Browser.)To apply a preset to a photo, click on the preset in the mini-browser or in the Quick View 
Browser. Presets are not cumulative; clicking on another preset will remove the previous one and apply the 
new one.

Once you’ve applied a preset, you can reduce its overall effect by hovering over the 
chosen preset. There, you will see a Fade slider, where you can lower the opacity of 
any Effects filters applied with the preset. (Develop and local adjustments included 
in a preset are not reduced.)

After you have applied a preset, you can still make changes to any of the settings—
in Develop, Effects, and Local Adjustments—add or remove adjustments, switch to 
another preset, perform any retouching or more. 

A preset with the Quick View Browser icon shown.

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser from the Window menu) will open a 
full-screen representation of that category’s presets, giving you a larger representation of how that preset will look on your image.

The Fade slider reduces the 
opacity of Effects filters 
applied with a preset.
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If you don’t like a preset, clicking on another one will replace the settings of the previous preset with the 
settings of the new preset. To remove a preset entirely, choose one of the reset options from the Settings 
menu, or remove the individual settings from the appropriate panes in Develop and Effects. (The latter 
approach is recommended if you have created masks or local adjustments that you wish to preserve.)

You can save a preset as a favorite by hovering over its thumbnail in the browser, and clicking on the 
heart icon. This will add that preset to a Favorites category that resides at the top of the Presets panel. To 
remove a favorite, click again on the heart icon.

Inserting Presets (Effects tab only)

When you click on a preset, HDR’s default behavior is to remove any 
existing adjustments and apply the newly chosen preset to your photo. 
Sometimes, however, you would like to add a preset on top of your 
adjustments. To do this, open the Presets pane, right-click on the preset 
you wish to add, and choose Insert Preset from the pop-up menu. This will 
add the preset’s filters above the currently selected filter pane  and will 
preserve any edits you made in the Develop or Local Adjustment tabs. 

Inserting a preset will only add that preset’s Effects filters to your currently edited photo. Develop 
adjustments and local adjustment layers will not be added.

CREATING YOUR OWN PRESETS

Once you have a group of edited settings that you wish 
to save, go to the Settings menu and select Save Preset. 
The Save Preset dialog will appear, with options for which 
module’s settings you wish to save, naming the preset, and 
adding it to an existing or new category. Nearly all of the 
Edit module settings can be saved as a preset, including 
cropping, retouching, and masks. To save your masks — AI 
adaptive or otherwise — check the Apply Masks option for 
each tab in the Edit module. 

If you have applied a preset to an image, and subsequently 
updated any of the edit settings (or add or remove 
adjustments), you can update the preset with the new 
settings by choosing Update Preset with Current Settings 
from the Settings menu. This will only change the preset in 
your app; any images that had the old version of the preset 
will keep those settings unless you reapply the preset. (You 
can also update a preset by right-clicking on the preset in 
the Preset Browser.) 

If you would like to create a new preset category—which will be added to the Presets panel throughout 
ON1 HDR—choose Add New Category from the category pop-up. 

CREATING AND USING AI ADAPTIVE PRESETS

When you use the Super Select AI tool or the Mask AI options in the Effects, Local Adjustments or in the 

The Inset Preset option is only available  
when working in the Effects tab.

The Save Preset window includes all of the operations 
possible in the Edit module, with the exception of layer 
operations. Filled circles to the left of a setting mean that the 
setting will be saved in the preset; click the circle if you don’t 
wish that setting to be saved.
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Layers panel, you can save those region selections when you create a new preset, by clicking on the Apply 
Masks item in the appropriate tab. Then, when you apply the preset to a new photo, anything (Effects filter 
or local adjustment) that had an AI-generated mask region — such 
as a sky — will be applied to those regions with the same name in 
the new photo. These preset types are called “adaptive,” meaning 
that they are applied to a photo based on HDR’s AI models.

Here are a few tips to think about when working with adaptive 
presets:

• It’s best to create an adaptive preset that only uses AI-
generated masks. If you save a preset where any filters 
or local adjustments have masks that have been created by the standard masking tools (like 
the Masking Brush or Masking Bug), those masks will be regenerated based on the precise 
location of the mask in the image that was used to create the preset.

• Any changes to the mask made via the Mask control options pane (see page 52) are saved 
with the preset.

• After you apply an adaptive preset to a photo, check the masks that the preset created. Quite 
often, you’ll find that you might need to use some of the mask refinement tools — or even the 
Masking Brush — to fine-tune your mask.

• Feel free to add your adaptive presets to any of the existing preset categories, or create your 
own category (see below for how to do that). For best practice, however, name or categorize 
adaptive presets such that you know which ones contain AI-generated selections.

MANAGING PRESETS AND CATEGORIES

You can perform a variety of operations on presets and preset categories, including importing and 
exporting presets (individually or by category), deleting individual presets, and hiding categories.

Importing & Exporting Presets

You can import presets you have downloaded from the ON1 website or other source. Some files will be 
individual presets, while others might be preset “packs,” which will include more than one preset.

A preset will have an ‘.ONP’ extension, while a preset pack has an ‘ONPreset’ extension; all you need to do 
is double-click on the file—or choose Import Preset from the Settings menu—and HDR 2023 will ask you to 
pick a category where you wish to place the preset or pack, and it will copy the presets into the app. You 
can delete the downloaded files, if desired.

To export an individual preset, click on it and choose Export preset from the Settings menu. You can also 
export an entire category of presets, via the category preset menu (shown below).

Deleting presets

To remove a preset if you no longer want to have access to it, select the preset you wish to remove in the 
Preset panel, and choose Delete Preset from the Settings menu. You can also right-click on an individual 
preset and click Delete Preset from the pop-up menu.

You can delete any preset, including the presets that came pre-installed with ON1 HDR. If you think you 
might wish to save a preset, export it first, then delete it.

Clicking Apply Masks in the Save Preset window 
will save your AI-generated regions. When you use 
that preset, those masks will be applied to similarly 
named regions.
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Managing categories

In addition to creating your own preset categories, which get 
displayed in the Presets pane, you can also perform other operations 
on categories, including deleting, renaming or exporting. These 
options are all available via the Preset Category pop-up menu, which 
is available when you hold right-click on a category name:

• To remove a category—and its presets—from the Presets panel, choose Delete Category from 
the pop-up.

• Choose Rename category if you wish to change the name of the category.

• To export a category and all of the presets within it as an ONPreset pack, choose Export 
Category from the pop-up menu.

TIP: Many preset management options can also be performed by clicking on a 
preset in the Preset panel and right-clicking on the preset. This is helpful if you 
want to update, export or rename a preset without applying it to an image in 
Develop or Effects.

Nesting presets

To help manage large groups of presets, HDR’s Extras Manager lets you nest preset categories. See page 
9 for details on how to create and manage preset category subfolders.

RESETTING EDITS

Any edits you have made with ON1 HDR 2023 can be completely reset from within the Edit module. 

The Settings menu offers six options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in the Edit module. (This 
option can also be accessed from the Reset All button at the bottom right of the Edit 
window.) 

• Reset Develop Settings: Removes only the settings applied in the Develop tab.

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset All Retouching Tools: Resets any retouching applied anywhere in the Edit module.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Crop: Returns the image to its original, uncropped size.

You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.

NOTE: The Reset settings work on the currently selected layer, not on the file.

Right-click on a preset category to get the 
category pop-up menu.
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Soft Proofing
ON1 HDR’s soft proofing feature lets you see 
how a photo will look when printed, using the 
color profiles that get installed with your printer. 
Soft proofing helps you determine where there 
might be issues when you print, so that you can 
adjust your tone, color and effects to give you a 
print that is closer to your editing vision.

Normally, when you’re viewing an image in 
HDR, you are viewing it through the lens of 
your monitor’s display profile. The color gamut 
of your computer’s display is wider than that 
of most photo printers, which means that 
some colors you are able to view on-screen 
are not reproducible when you print. When 
this happens, the color profile conversion 
that happens in the print engine will cause 
substitutions of colors that the printer cannot 
print to the closest color that it can. This means 
that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, 
or by clicking on the soft proofing icon to the 
left of the Preview button at the bottom of the 
main HDR window. You soft-proof various paper 
types by choosing an installed printer profile 
from the Profiles submenu. The image will 
change to approximate the color of the paper 
you’re profiling. You can also turn on an overlay 
that will display out-of-gamut colors.

The primary soft-proofing options are available 
underneath the Enable Soft Proofing item in the 
View menu. The options are as follows:

• Gamut warning: When checked, this 
displays colors in the image (via a 
red overlay) that don’t correspond to 
the current printer profile being soft 
proofed.

• Profiles: The Profiles submenu lists 
the currently available printer profiles. 
Choosing one will change the on-
screen display to use that profile. You 
can also import profiles via this submenu.

These three screen shots show the results of soft proofing options, as viewed 
in the Edit module. The top image is with soft proofing off (and is using the 
display color profile). The middle image is with soft proofing turned on, and 
using a printer profile for Epson’s Velvet Fine Art Paper. The bottom image has 
the Gamut warning turned on; out of gamut colors are highlighted by the bright 
red overlay.
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• Intent: HDR offers two different rendering “intents” when soft proofing, which are used to 
convert the color from display to print. Perceptual shrinks the color gamut during the 
conversion, which works to preserve the relationship between colors in the image. The other 
intent type, Relative, only converts colors that are outside the current color gamut, but this 
can sometimes cause two colors, one in gamut, and one outside, to be identical after 
conversion.  
 Neither rendering intent is perfect or desired; it often is a 
matter of the makeup of the image, your editing intent, the 
paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, 
seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause 
HDR to use the white point for the chosen paper type 
(instead of the white point of your monitor), and the paper’s 
actual black density (instead of the display’s black point). 
If you’re trying to match a print, you will usually want this 
setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. 
It’s easy to get caught up in eliminating out-of-gamut colors, but most 
modern photo printers—both home printers and online print services—
do a pretty good job of properly approximating colors. 

The biggest thing you want to be looking for when viewing a soft proof 
is tone, contrast and color accuracy between screen and print. When 
using a home printer, use test prints to hone in on the right mix of Edit 
module adjustments. 

Other Preview Options
In addition to soft proofing, ON1 HDR 2023 
offers a few other previewing options in the Edit 
module, which can be found in the previewing 
section at the bottom of the HDR window. With 
these options, you can compare the before 
and after views of a photo—in either split-screen or full-screen views —see the current mask, and turn soft 
proofing on or off. 

CHANGING THE MAGNIFICATION VIEW 

HDR includes various options for zooming in or out of a photo while you’re working on it. In addition to the 
Zoom tool and the Navigation pane (see page 49 and page 23, respectively), you can change the zoom 
view by moving the magnification slider. You can either click on the control and slide it to the right to zoom 
in and to the left to zoom out, or you can click on the boxes at the ends of the slider.

The Profiles submenu displays the installed 
printer profiles for any installed photo 
printer. You can also import your own color 
profiles.

The Preview area at the bottom of the main HDR window includes options for 
adjusting the preview magnification, turning compare (before/after) view on or 
off, viewing the current mask, turning soft proofing on or off, and for viewing 
the original photo, with all edits removed.
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BEFORE/AFTER PREVIEWS

As you work in the Edit module, it can be helpful to see how individual edits—via items in the different edit 
tabs—affect your photo, as well as to see the cumulative changes made to the original image. The Edit 
module’s Compare mode displays a side-by-side view of your photo, with the original version on the left, 
the edited version on the right. There is a movable slider in the middle of the screen, which lets you view 
more or less of each view; click on the box at the center of the slider and drag it to the left (to view more of 
the edited image) or to the right (to view more of the original. While working in Compare view, you can use 
the magnification slider to zoom in or out of the image, which can be useful when you wish to see the 
effects of your edits on smaller sections of your photo.

You can also view your original image full-screen by clicking the Preview button at the far right of the 
previewing toolbar. When you click this button, the original photo is displayed with a “Preview Off” overlay. 
To return to your edited version, click the Preview button again. (You can also use the backslash key—‘\’—to 
show and hide the full-screen preview.)

SHOW/HIDE MASK

ON1 HDR 2023 has extensive masking capabilities throughout the Edit module. While you’re in the process 
of creating a mask, you have two options for displaying the contents of a current mask: 

• As a transparent red overlay, where the masked sections of your photo are shown in red.

• As a grayscale mask, where you do not see the photo, but see only the mask. Masked areas 
are shown in shades of gray, with pure black meaning that those pixels are completely 
masked. Gray values (from 1% to 99%) represent the opacity of the those pixels relative to 
the mask, and areas of pure white are not masked.

Edit’s Compare view displays a before/after view of your current photo, with a movable slider for expanding and contracting the different 
views.
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The overlays can be set in the Mask menu’s View Mode submenu while you are working in the Edit module. 
(You can also, via this menu, show the mask as a red overlay only when you are brushing a mask.) You can 
toggle the current mask view by clicking on the Show Mask icon in the previewing toolbar, or by pressing 
the O key.

For more information on the varying aspects of masking in ON1 HDR 2023, check the respective masking 
tools earlier in this chapter, as well as the “Filter Masks” on page 81.

FOCUS AND CLIPPING VIEWS

Two additional previewing tools that can be quite powerful aids when you are editing photos are the 
Clipping and Focus Mask overlays. These options can be displayed in any of the Edit module tabs.

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, 
rather than fading smoothly. (Large expanses of white pixels 
in a photo are often referred as ‘blown’ highlights, and can be 
quite distracting to a viewer.) One of the benefits of shooting 
in raw format is that, while many photos will have areas of 
pure white or black when originally viewed on-screen, there 
is still recoverable data in the raw image. The Clipping overlay 
can help determine how big a problem you might have with a 
photo, and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; 
to turn it on permanently as you move from photo to photo, 
choose View > Show Clipping, or press Alt (Windows) or 
Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a 
lot of photos from a shoot, it can be a bit tedious to check 
focus at that level. Luckily, HDR’s Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt-J (Windows) or Shift-Option-J (Mac). The 
sharpest areas in your image will be represented by a bright 
green overlay. As you move from photo to photo in a folder, 
you’ll be able to tell whether you have an acceptable level of 
sharpness where you need it by the strength of the overlay. 
The mask will continue to be displayed even as you zoom in 
on a photo.

Clipping view displays pure white pixels with a bright red 
overlay, and pure black pixels with a bright blue overlay.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.
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SHOWING OR HIDING EDIT MODULE ADJUSTMENTS

You can also show or hide many individual adjustments made throughout the Edit module. Most of the 
panels in the Develop, Effects and Local tabs have a Show/Hide control in the upper left-hand corner of the 
panel. You can make your adjustments, and can click the control to turn the effect on or off. 

That this option is not solely for 
previewing an effect; if the adjustment 
is turned off, it will not be present 
in the edited image. This can be 
helpful if you’re trying different 
filters in Effects, for example, and 
you want to see if one looks better 
than another, or if you wish to see if it 
truly helps the photo or not. To turn 
the adjustment back on, click on the 
Show/Hide control so that the circle is 
filled.

The only adjustment inside the Edit module that cannot be turned off in this way is the Tone & Color panel 
in the Develop module. If you wish to view your photo without those adjustments, you need to press the 
Reset icon, which is represented by ‘⟲’ at the top right side of the panel. 

For a complete description of the controls in most Edit module panels, see page 77.

Saving Your Work
ON1 HDR saves your non-destructive settings for the photo you are editing when you return to the startup 
screen. If you would like to periodically save your settings during your editing session, you can use the Save 
Settings command. This saves your work in the off chance the application encounters an error. To save the 
current state of your actions, choose Save Settings from the Settings menu, or press Command-S (MacOS) 
or Control-S.

To turn an effect or other adjustment off, click on the Show/Hide control in the upper left of 
an adjustment’s panel. If the control’s circle is empty, that effect is not implemented. Clicking 
the control will turn it back on.
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PART 4: BASIC EDITING WITH DEVELOP

Develop is the module for performing basic global editing operations—adjusting tone and color, removing 
noise, sharpening and applying transforms to a photo. It is the perfect place to begin editing your photos. 

Develop Adjustment Panes
The Develop tab has four adjustment panes found in the Overall Settings panel. Unlike the Effects tab, 
which lets you stack filters in any order, the Develop tab’s adjustments are applied in the following order:

1. Tone & Color

2. Details

3. Lens Correction

4. Transform

WORKING WITH PANES

The Tone & Color pane is at the top of the stack, followed by Details, Lens Correction and Transform. 
These panes are not removable from the stack, although you do not have to apply any of these operations 
to a photo. The remaining panes can be applied based upon what you wish to do with your photo. Clicking 
on the button to the left of the pane’s name will turn that pane on or off, which can be helpful if you want 
to see the effect in the context of other edits you have made. The Reset button—designated by the circular 
arrow icon at the top right of each pane—will reset that pane’s settings to their default state.
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TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the bar, but the entire title bar 
is clickable). If you don’t want to have to scroll up and down the Settings panel 
when you have a lot of open panes, choose Solo Mode from the Window menu. 
This will leave only the current pane open, and will hide all the other panes. 
Clicking on another pane will open that one and collapse the previous one.

TONE & COLOR

This pane adjusts the tonal and color characteristics of an image, 
letting you correct and enhance exposure, contrast, detail and 
color. It is split into two sections, Tone and Color, with a Color 
Profile option at the top of the pane.

Camera Profile

Camera profiles apply alternative interpretations of the raw data 
in an image based upon different genre types or intents. The 
pop-up menu displays HDR’s built-in profiles: ON1 Standard, 
Landscape, Portrait, Vivid and Neutral. If your camera has its 
own embedded profiles, you will see those profiles in the list as 
well, and you can also import your own custom camera profiles 
using HDR, and X-Rite’s ColorChecker and ColorChecker Camera 
Calibration software. (See page 74 for more information on 
how to create and import custom camera profiles into HDR.)

HDR’s camera profiles are non-destructive, and work 
independently of any changes you make to tone or color.

Tone

The Tone sliders control the global tonality, or brightness and  
contrast of the image. You can adjust each of the following:

• Manual, AI Match and AI Auto buttons: The AI 
Match button uses artificial intelligence technology to 
automatically adjust the controls in the Tone panel to 
closely match your photo as you saw it on the back of 
your camera’s display (this option is only available when 
opening individual raw files inside ON1 HDR). The AI 
Auto button performs an automatic tone adjustment 
on your photo using a proprietary ON1 algorithm. If 
you don’t use either of these options, or if you make 
subsequent adjustments, the Manual button will be 
highlighted.  

• Auto Tone slider: This option is only available when using the AI Match or the AI Auto option. 
Using this slider will let you ‘fade’ the effect of those options.
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• Exposure: Adjusting this slider to the right will lighten your image. Adjusting to the left will 
darken your image.

• Contrast: Increase or decrease the contrast in your image.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing contrast in the shadows.

• Structure: Adjusts the detail in your image by changing the local contrast.

• Haze: When moved to the left, this will remove haze or fog from your photos; moving it right 
will enhance fog or haze.

NOTE: The AI Match and AI Auto buttons only affect the tone and saturation 
of your image; they don’t adjust the white balance. If you wish to change the 
white balance, use the Auto button in the Color section of the panel, or adjust 
the Temperature and Tint sliders as desired, as described below.

Color

The Color sliders control the Temperature, Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. By default, when working with raw (or DNG) files, the color temperature is 
measured in degrees Kelvin (°K), which gives you a larger and more accurate range to make adjustments. 

The settings in this section of the Tone & Color pane include:

• Auto Button: The auto button attempts to detect and remove a color cast. It makes 
adjustments to the Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. Click the icon to activate, then click 
on an area in the image that should be gray.

• White Balance presets: This pop-up lets you change the white balance according to common 
color temperatures (As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, 
Custom). The default is As Shot, which is the color temperature that the camera recorded 
when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow). When editing 
a raw file, the °K button will be blue, which means that the temperature is measured in 
degrees Kelvin. Clicking the button will change the slider to a relative color ramp. (The Kelvin 
ramp is only available when working with raw photos; other formats use the relative slider.)

• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases/decreases the color of muted tones, leaving more saturated colors alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.
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• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.

Adjusting Tone & Color settings via hotkeys

When you’re working in any tab inside the Edit module, 
you have the capability to adjust the basic tone and color 
settings for your current image directly from the keyboard, 
based on the hotkeys found in the Keyboard Shortcuts 
window. These include the following sliders: Exposure, 
Contrast, Highlights, Midtones, Shadows, Whites, Blacks, 
Temperature, Tint, Saturation and Vibrance.

To use this feature, first invoke the setting you with to 
change with the appropriate keyboard shortcut. An on-
screen overlay label will appear, indicating that you are 
changing that setting. Use the Up and Down arrow keys to 
increment or decrement the chosen slider. When you’re done, press the Escape key, or click in the window.

This feature can be helpful when, for example, you apply a set of filters in Effects and feel that they caused 
the shadows to darken in your image. Using the keyboard shortcut for the Shadows adjustment, you can 
make changes dynamically without having to go back to the Develop tab.

ON1 HDR 2023 has a set of pre-assigned keys for these adjustments in the Develop section of the 
Keyboard Shortcuts window, but you can change them easily. See “Customizing ON1 HDR’s Keyboard 
Shortcuts” on page 13 for more. 

DETAILS

The Details pane incorporates sharpening and noise reduction, two 
adjustments that often compete with each other when working on 
a photo. We’ve added them together into a single pane to help you 
achieve the right balance between sharpness and noise during your 
initial photo editing. 

Sharpening

The sharpening section of the Details pane is designed to help 
visually sharpen an image based on its initial state from your 
camera—for example, to bring back some sharpness that might 
have been lost. It has two basic controls: Amount and Threshold. 
Amount controls the strength of the sharpening applied, while 
Threshold reduces sharpening in areas of low detail via a threshold 
mask. 

If you hold down the Option (Mac) or Alt (Windows) key as you 
adjust the Amount slider ON1 HDR will display your photo in 
grayscale, which can make it easier to view the degree of sharpening you’re applying.

With the Threshold slider, a setting of 0 means that the sharpening amount gets applied to every 
pixel. As you increase the amount, it focuses the sharpening only where there is a difference between 

You can view (and change) the hotkeys for the primary Tone 
& Color adjustments from the Keyboard Shortcuts window, 
which is found in the Edit menu.
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neighboring pixels. To help you determine which edges are sharpened, you can use the same Option/Alt 
key trick mentioned above. In this view, as you adjust the Threshold slider, everything that is white will get 
sharpening applied to it; everything displayed as black will not have sharpening applied.

NOTE: When you are adjusting the sharpening or the noise in a photo, it is 
best to be working at 100% view. To do this, you can click on the 100 button in 
the Navigator pane, choose View Actual Pixels from the View menu, or press 
Command-Option-0 (Mac) or Control-Alt-0 (Windows) on your keyboard. 

Noise Reduction

The Noise Reduction section reduces luminance and color noise, while maintaining image detail. By default, 
ON1 Photo applies a small amount of noise reduction on your photo, based on the camera type used. You 
can then further refine both luminance and color noise, as defined below:

• Luminance: Adjusts the overall strength of the noise reduction applied to the luminance or 
detail of the image. Hold down the Alt/Option key to see just the luminance while adjusting 
this slider.

• Color: Controls the amount of noise reduction applied just to the color noise or chroma, of 
the image.

• Detail: Controls how much edge detail is protected. Hold down the Alt/Option key to see the 
edge mask while adjusting this slider.

• Remove Hot Pixels: If you have any individual, blown-out pixels in your image, turning 
this setting on will remove them, changing that pixel’s color to one that blends in with the 
surrounding pixels. This setting can also be helpful in reducing noise in long exposures.

The Details pane is intended to adjust the base-level sharpening and noise reduction of a photo. If you wish 
to apply further sharpening for printing or other output uses, you can add more targeted sharpening in the 
Effects tab, or the Print window, if you wish to sharpen for output. 

Styles

The Details pane has a set of built-in styles in the top part of the pane. Styles are like preset adjustments 
for a pane: they provide a group of settings to help you get started in the pane, or to apply a specific effect.

You use a style by clicking on the style’s icon in the pane, and then can adjust the sliders as desired to get 
the right effect for your photo.

You can save your own settings as a style. Simply click on the More icon on the far right side of the styles 
list for that pane, then choose Save New Style from the pop-up. Name your style, and it will then be 
added to the top of the More menu. To apply a saved style, choose the style from the More pop-up menu. 
To adjust the settings for a saved style, apply it, make any changes you would like to the sliders or other 
options, then click on the More pop-up and choose Update Style with Current Settings from the menu.
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LENS CORRECTION

The Lens Correction pane uses the lens metadata embedded in a 
photo and searches HDR’s internal lens database for an appropriate 
profile. If found, the profile will be applied automatically, reducing 
distortion, color fringing (chromatic aberration) and peripheral 
fall-off. You can also make your own manual lens-correction 
adjustments, if you prefer.

NOTE: Lens profiles can only be applied to raw photos 
that are opened when using ON1 HDR as a standalone. 
If you use HDR as a plugin from Lightroom or Capture 
One, lens profiles will not have any effect on your photo, 
although adjustments made in the Manual section of the 
pane will get applied to your final photo.

ON1 HDR detects embedded lens profiles in modern lenses from 
Panasonic, Fujifilm, Canon, Nikon and Sony. The lens database 
also has hundreds of profiles for many third-party lenses from companies like Tamron, Sigma, Tokina, Zeiss, 
Voigtländer and others. It will automatically apply a profile when the camera and lens models are from the 
same manufacturer. 

When working with third-party lenses and your specific camera, you can use the Lens Profile section of the 
Lens Correction pane to find the appropriate lens profile from the database and apply it to your image. 
When you do this, you will be asked if you wish to apply this lens profile to any other images for that lens. If 
you say yes, the profile will be saved as a custom style in the Lens Correction pane, and will be applied 
automatically every time HDR sees this combination.

If the app doesn’t have a built-in profile for your lens, it 
will automatically attempt to correct the image in real 
time, based on a comparison between the embedded 
JPG of the raw image and the raw data itself. In this case, 
there is no need to save the correction as a style—if 
you feel that this representation is accurate. If it needs 
tweaking, you can further adjust the correction in the 
Manual section of the pane (see below), and then save the correction as a style and apply it to other images 
taken with that lens and camera combination. (They will not be applied automatically, however.)

Applying Manual Lens Correction

To apply your own lens correction to a photo, click on the Manual triangle at the bottom of the pane and 
choose the manufacturer of the lens (or the camera make, if you don’t have that). The Manual section lets 
you adjust the following parameters:

• Pincushion (where lines in a photo curve inward) or barrel (lines curve outward) distortion;

• Purple or green color fringing that might occur along edges in an image shot with that lens/
camera combination; and

When you pair a camera with an existing lens profile from a 
third-party lens manufacturer, HDR will ask if you would like to 
use that profile on an all images with this combination. 
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• The light fall-off (vignetting) that can occur at the outer edges of a lens at certain focal 
lengths or aperture. Once you’ve adjusted the sliders as needed, choose Save New Style from 
the Style pop-up to use this profile on other lenses. 

NOTE: Lens corrections are applied automatically inside ON1 HDR, but you 
can turn this setting off via Default Processing section of the Preferences’ 
File tab (see page 125). If you have this setting turned off and wish to apply 
corrections to an image, you must enable the Lens Correction pane in the 
Develop module.

A list of the currently supported lens profiles can be found on the ON1 support website, via this link.

TRANSFORM

Transform applies distortion and perspective correction to your 
image, and offers rotation and scaling options as well. You can 
use these settings to make small adjustments to perspective or 
distortion.

The three icons at the top of the pane let you apply specific 
transforms to the current photo:

• Keystone lets you project your image as if it were on 
an angled surface. This type of effect is often used to 
help adjust the perspective in architectural photos. 
Selecting the Keystone option will give you a box with 
four handles at the corners. You can extend the handles 
in any direction. Once you’re done, click on the Apply 
button at the center of the keystone box.

• Level works in a similar fashion to the one found in the Crop tool (found on page 26). 
Select the tool and click and drag across an element in your image that should be level.

• Move lets you adjust the image’s position on the canvas. Click and drag to reposition.

Keystoning can be helpful when you want to adjust the perspective in a photo; just adjust the four corners 
to align with an object that should have parallel lines, like a window or door, then click the Apply button. 
The Transform pane doesn’t apply a crop when you apply a transformation; use the Crop tool for that.

In addition to the above tools, the following options will apply specific transform operations:

• Vertical: Adjusts the vertical perspective.

• Horizontal: Adjusts the horizontal perspective.

• Rotation: Rotates the canvas up to 45° clockwise or counterclockwise.

• Scale: Scales your image up from the center, to 100%.

• Aspect Ratio: Stretches your image horizontally (moving the slider to the left) or vertically (to 
the right).

https://on1help.zendesk.com
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• Shift: Translates the image left or right.

• Rise: Translates the image up or down.

The Grid pop-up menu at the bottom of the Transform pane lets you displays a grid overlay while you are 
adjusting the pane’s sliders. The default for the pane is No Grid, but you can also choose between 10% 
(large), 5% (medium) or 1% (fine) grid settings.

The Transform tool works best most of the time in small amounts. It’s not necessarily going to fix a photo 
with an extreme perspective, but it can often help with slight adjustments, especially if you fine-tune them 
with some of the Transform panel’s other controls or the Manual section of the Lens Correction panel. In 
addition, the tool does not apply a crop after an operation; if you are happy with the transform results, use 
the Crop tool to finish your work.

The Transform pane’s Keystone option can help with perspective issues in a photo. Clicking the Keystone icon gives you a box that you can 
use to align the four corners of an object that should have parallel lines (above left). Once you have the edges of the object aligned, click the 
Apply button in the center to create the transform, and apply a crop as necessary. (Sometimes, you’ll find that using the manual section of 
the Lens Correction pane can help reduce some of the distortion that the Keystone operation can create.)
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CREATING AND ADDING CUSTOM CAMERA PROFILES

As noted in the section on the Tone & Color panel (page 66), you can create your own custom camera 
profiles and import them into HDR. Custom camera profiles can help improve the fidelity of color 
reproduction in your photos, and for some photographers, this can be a useful tool. 

To build a new profile, you’ll require a color 
profiling target and special software that 
creates the profile. ON1 worked with X-Rite 
Inc. during the development process to create 
a workflow that helps ease this process and 
ensure consistent results when building camera 
profiles. In addition to ON1 HDR 2023, you’ll 
need a reference target, such as one of the 
ColorChecker series, and X-Rite’s ColorChecker 
Camera Calibration app. 

The process for creating a custom profile is as 
follows:

• Turn off automatic white balance on 
your camera; set it to the lighting 
conditions—daylight, tungsten, flash, 
fluorescent—in which you are shooting 
the target.

• Place the color reference target in the 
center of your scene, with even light. 
Take the photo.

• Open the photo in HDR’s Develop tab.

• In the Camera Profile section of the 
Tone & Color panel, choose the Linear 
Raw profile from the pop-up.

• Click on the dropper icon in the Color 
section of the Tone & Color panel (see 
page 68), and click on one of the 
light gray patches in the target. This 
will neutralize the image.

• Using the Export feature, export your 
photo as a TIFF, selecting the Camera 
Calibration color space from the pop-
up under the file type option. (See page 102 if you need help with exporting photos from 
HDR.) 

• Using X-Rite’s ColorChecker Camera Calibration software, open the exported TIFF file. 
The app should find and align the target; if so, click the Create Profile button, and save the 
exported profile. If it doesn’t find the target, follow the guidelines in the software to help 
improve your chances with a new photo.

• In HDR, go to the Develop module with a photo created with the camera you profiled. In the 

When you open the photo with the color target, set the camera profile to 
Linear Raw, and use the gray dropper to neutralize the photo, by clicking on 
one of the light gray targets (circled, above).

When exporting your neutralized target, set the 
file type to TIFF, and the color space to Camera 
Calibration Space.

Using X-Rite’s ColorChecker Camera Calibration app, you can open the 
exported TIFF file, and create your own custom camera profile. Then, import 
the profile via the Camera Profile pop-up in Develop to use it with any photos 
taken with that camera.
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Tone & Color panel, click on the Import Profile item in the Camera Profile pop-up menu. Find 
the exported profile and choose Open. Your profile is now installed.

NOTE: You can find the different ColorChecker options on the X-Rite website 
at xritephoto.com/camerasolutions.
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PART 5: STYLIZING WITH EFFECTS

If Develop is the base from which you start editing your photos, Effects is the finishing school. With eight 
filters that can be stacked in any order, and with extensive blending and masking options, Effects lets you 
create stunning, pro-level photos with ease. And, since it is built upon ON1 HDR 2023’s non-destructive 
editing engine, you can go from Develop to Effects to Local and back again, preserving your edits, masks 
and more without having to worry about saving multiple versions of your files.

While Develop and Effects share the same tools, Effects is much more customizable in how adjustments—
called filters in Effects—are applied. The editing stack inside Develop is fixed, while the stack in Effects is 
extremely flexible. Here are just a few of the things you can do with an image in Effects:

• You can add filters in any order (even multiple instances of the same filter).

• Move filters up and down in the stack.

• Add blending options to all or some of the filters and set the opacity of each filter individually.

• Create complex masks for each filter you add, letting you selectively apply a filter to specific 
portions of an image.
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Filters
Filters are the building blocks of Effects’ editing power. Each filter is an adjustment type, much like the 
basic adjustment panes inside Develop, but Effects filters have much more functionality than the Develop 
panes. The Effects tab has eight filter types, added either by the Add Filter button found at the top of the 
Effects tab, or via the Filters pane on the left side of the window. You can apply filters in any order, and 
you can have more than one instance of a filter in the stack. This can be helpful when you are creating 
complicated masks on an image and wish to apply the same filter differently in parts of the photo. And, like 
everything else in ON1 HDR, filters can be added, adjusted and removed easily, and they never affect the 
base image that you start with.

Each filter is like a movable, editable layer over the base image you are working on. You can use HDR’s 
masking tools to apply a filter to only part of an image and can change the blending mode (and opacity of 
the filter) to alter the way the filter interacts with those above and below it in the stack. And, when you add 
a filter via the Filters window (see below), you can use ON1’s Mask AI technology to select a region in your 
photo and apply the filter to that area automatically — without using any of the built-in masking tools.

FILTER OVERVIEW

Each filter pane has a different set of adjustment 
options and controls, but every filter pane has the 
same five sections:

A. Filter on/off button (left); Show/Hide Mask 
(right). Clicking the mask icon will open the 
Masking Control Options section for that 
filter’s mask.

B. Displays blending mode options (left); Resets 
filter (middle); Deletes filter from the stack 
(right).

C. Filter opacity setting.

D. Styles pane for filter presets.

E. Control area for adjusting that filter’s specific 
settings (these control options change, based 
on the filter chosen).

APPLYING FILTERS WITH THE ADD FILTER BUTTON

If you click the Add Filter button at the top of the Effects tab, the Filters window opens up, with a list of 
all eight filters on the right side of the window, and the Mask AI pane on the left (see screenshot on the 
following page). If you run your cursor over a filter name, the right side of the window will have a small 
before/after thumbnail, a short description, and a list of keywords that relate to that filter. To add a filter, 
click once on the filter name, and it will add it to the stack, above the current filter. If there aren’t any filters 
in the stack, the new filter will be at the top of the stack. You can click and drag the title bar in any filter to 
move it up or down in the stack.
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If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. ON1 HDR will then narrow down the search to those filters that 
match your search terms.

Using ON1 HDR’s AI-based tools to mask regions automatically

Normally, when you add a filter, the filter is placed at the top of the Effects stack, and is applied to the 
entire image. If you’d like to selectively apply a filter automatically to specific areas in a photo, you have 
three options:

• You can use a tool like the Super Select 
AI tool to select a region and create 
a filter in Effects (see page 30 for 
information on using this tool).

• To add a filter from within the Effects 
tab, choose the Add Filter button, and 
select the region in the Mask AI section 
on the right side of the Filters window.

• If you have an existing filter, you can also 
select a region from the masking control 
options section of the filter.

In addition to these options, you can also use an AI 
adaptive preset when you wish to create selections 
based on regions in a photo. (See page 56 for 
more on presets and their application.) 

If you click the Add Filter button at the top of the Effects tab, the Filters window opens up, with a list of all 
nine filters. If you run your cursor over a filter name, the right side of the window will have a small before/
after thumbnail, a short description, and a list of keywords that relate to that filter. To add a filter, click once 
on the filter name, and it will add it to the stack, above the current filter. If there aren’t any filters in the 
stack, the new filter will be at the top of the stack. You can click and drag the title bar in any filter to move 
it up or down in the stack.

When you click on the Add Filter button in the Effects tab, the Filters window is displayed, which consists of the Mask AI controls 
(left), the list of filters (center), and a description (right) of the filter your cursor is currently hovering over, with a sample preview 
(including a before and after split view).

In addition to using the Super Select AI tool to add filters selectively to a 
photo, ON1’s Mask AI technology can be found in the Add Filters window 
(above left), and in the masking control options section of the filter itself. 
(Click the mask icon in the filter to open the mask options section.)
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If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. HDR will then narrow down the search to those filters that match 
your search terms.

APPLYING FILTERS WITH THE FILTER BROWSER

In addition to the Presets panel, Effects has an 
additional Filter panel on the left side of the 
screen. This panel lets you browse all of the 
filters inside Effects, and display previews of the 
available styles for that filter. 

To choose the Filters panel, click on the Filters 
tab. A list of the filters will appear, and clicking 
on a filter will display thumbnails of your image 
with that filter’s available styles. To choose one, 
click on the style, and Effects will add that filter 
to the Overall Settings pane. Note that this will 
replace the currently selected filter in the stack; 
to add a new one on top of the stack, click the 
Add Filter button at the top of the Effects tab on 
the right, then choose a filter from the list. (You 
can also click and drag the title bar of any filter 
and move it up or down in the stack.)

If you’d like to see a larger representation of 
what your selected photo will look like with a 
filter’s styles, click on the Quick View Browser 
icon in the category’s title bar. That will display a 
window with all of the presets in that category. 
(Press the Escape key to close the Quick View 
Browser.)

To change the size of the thumbnails in the filter 
styles panel, select the Browser Mode option 
from the View menu and choose One, Two or 
Three Column Thumbnail View. (If you choose 
Thumbnail from the Browser Mode submenu, 
the Filters and Presets panels will display as 
thumbnails.)

If you’d like help with what the different filter operations do, click on the Info button at the top right of the 
panel. With that button checked, when you hover over a filter, HDR will display a small pop-up window 
containing the same description (with before/after thumbnail) found in the Add Filter window. Click the 
Info button again to turn off this display.

Searching for filter styles inside the Filter Browser

To search for styles inside the Filter Browser, type in the name in the search field at the bottom of the 
panel. The search results will appear in a new subfolder called ‘Search Results.’

The Filter Browser has a list of all the filters available in Effects (left). Clicking 
on a filter will display thumbnails of the filter’s styles using your photo (right). 
You can also click the icon on the right side of any filter to view the styles in 
the Quick View Browser.
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Saving filter styles as favorites

If you hover over a filter style’s thumbnail in either the Filter Browser or the Quick View Browser, you’ll see 
a heart icon. Clicking the icon will add that style to your Favorites category. This category resides at the top 
of the filter list, and contains all filter styles you have selected as a favorite. To remove a favorite, open the 
Favorites category, and click again in the heart icon.

To apply a style to a photo, simply click on the style in the Filter Browser or in the Quick View Browser.

WORKING WITH FILTER PANES

By default, the filter stack is empty, although, if you have applied a preset that uses filters from Effects, you 
will see those filters in the stack. Clicking the button in the top left corner of the filter pane will turn that 
effect on or off, which can be helpful if you want to see the effect in the context of other edits. If you don’t 
like the effect, click on the ‘X’ icon in the pane’s title bar to get rid of it. The Reset button, which is next to 
the Delete button, represented by ‘⟲,’ will reset that pane’s settings to their original state.

To move a filter up or down in the stack, click on the pane’s title bar and drag it up or down. A heavy white 
line will appear between panes as you drag; let go of the mouse at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the title bar, but the entire title 
bar is clickable). If you don’t want to have to scroll up and down the filter stack 
when you have a lot of open panes, go to the Window menu and choose Solo 
Mode. This will leave the current pane open, and will hide all the other panes. 
Clicking on another pane will open that one and collapse the previous one.

STYLES

All of the Effects filters have a set of built-in styles 
in the top part of the pane. Styles are like preset 
adjustments for a pane: they provide a group of 
settings to help you get started in the pane, or to 
apply a specific effect.

You use a style by clicking on the style’s icon in the 
pane, and then can adjust the sliders as desired to 
get the right effect for your photo.

You can also save your own settings as a style. Simply click on the More icon 
on the far right side of the styles list for that pane, then choose Save New 
Style from the pop-up. Name your style, and it will then be added to the top 
of the More menu (see right). To apply a saved style, choose the style from 
the More pop-up menu. To adjust the settings for a saved style, apply it, make 
any changes you would like to the sliders or other options, then right-click on 
the More pop-up and choose Update Style with Current Settings from the 
menu.
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FILTER MASKS

Every filter (and local adjustment) has a mask associated with it, which lets you apply that filter’s effect to 
specific areas of an image, using the Masking Brush (or the Local Adjustment Brush and Gradient, when 
working in the Local tab) and Masking Bug tools. By default, the mask is white, which means that the effect 
is visible in every part of the image. Using the Masking Brush, for example, you can ‘paint out’ the effect in 
areas that you wish not to be affected by the filter. Alternatively, you can invert a filter’s mask and choose 
to ‘paint in’ the filter where you would like it to be.

When you add a filter, the mask is technically hidden. You can add one by either selecting and using one of 
the two masking tools, or by clicking the Show/Hide Mask icon in the title bar of the filter pane (this icon 
will initially be represented with a plus sign in the middle of it). When you add a mask in either way, the 
contents of the Show Mask icon will represent the mask on that filter layer.

HDR has two options for viewing the contents of a mask: either as a red overlay on top of your image (the 
default) or a view only of the mask itself, represented as grayscale. These options are available from the 
Mask menu; select Show Mask to see the mask, while the View Mode option lets you switch between the 
two modes. (HDR will remember the previous settings.)

The Mask section of any effect or local adjustment has the following contents, as shown below (using the 
Glow filter as an example):

A. The Show/Hide Mask icon, which displays 
the contents of the current mask. The default 
mask contents are white when you add 
an effect, and black when you add a local 
adjustment layer.

B. Buttons for opening the blending options, 
resetting the filter, and removing the filter 
from the stack.

C. Sets the overall opacity of the masked effect.

D. Mask AI selection pop-up. Displays a list of 
the known regions in the current photo. To 
create a mask with any of the specified areas, 
click on the item and choose Apply

E. Larger display of the current mask, with 
buttons to invert, reset, copy, paste, create 
a luminosity mask, and view/hide the mask 
contents.

F. Mask adjustment tools. Density adjusts the 
overall mask density from black (100) to white 
(0). Feather blurs the mask. The Levels and 
Window settings let you adjust the black and 
white points of the mask, fine tuning them in 
different ways.

G. The Color Range option lets you choose a color (selected via the dropper tool), and make or 
tune the mask based on the range of the color selected.

Overview of the Mask Options section of a filter pane in Effects, 
showing a luminosity mask. Mask Options is also applicable when 
working in the Local Adjustments tab, or on a layer in the Layers 
pane.
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For more details about creating and manipulating masks in ON1 HDR—as well as some tips and tricks for 
working with masks—see “Masking Basics” on page 50; information on the Masking Brush and Masking 
Bug tools starts on page 35. 

DELETING A FILTER

You remove a filter by selecting it and pressing the ‘X’ icon to the right of the filter’s pane.

FILTER OPACITY

Every filter has an opacity setting, which effectively adjusts the strength of the filter. The Opacity slider, 
which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 (full effect). What this 
means is that at 100, all of the filter is applied to the image in the stack. At 50, the filter strength is half, and 
the effect is much less strong. Playing with a filter’s opacity can often help soften an effect in a way that 
you wouldn’t be able to get otherwise.

For example, if you add a Black & White filter to an image, but would like a faded, muted color effect, 
reduce the opacity of that filter. The more you reduce the opacity, the less effect the filter will have.

By default, when you add a filter, the opacity will be set to 100. You can create presets, however, with 
whatever opacity you wish for a given filter.

BLENDING MODES

In addition to opacity, you have one other very powerful option for adjusting the strength and effect of a 
filter: blending modes. Blend modes determine how a filter interacts with the filters below it in the image 
stack. Blend modes can darken or lighten an image, depending upon the mode chosen, while others adjust 
contrast or color. ON1 HDR 2023’s blend modes also let you apply a blend mode to specific colors or 
tones in your image, making them a very useful tool for precision editing of your images. You can apply 
sharpening, for example, only to the midtones in an image, which can be very helpful in a landscape image.

To see the blending modes, click on the Blending 
Options gear icon at the top of a filter’s pane. 
The Blending Options area will drop down 
from the top of the panel. The blending option 
controls are:

• Blending Options: A pop-up list of 
blending modes. There are 24 common 
blending modes available in the list, 
including Normal, Lighten, Darken, 
Screen, Multiply, Soft Light, Hard 
Light, Overlay and Color.

• Apply To: This lets you apply the 
blending mode to a specific color 
or tonal range. The options are; All 
(the default), Highlights, Midtones, 
Shadows, Reds, Greens, Blues, 
Magentas, Cyans, Yellows, Flesh 
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Colors, Vivid Colors and Neutrals. (You can also manually choose a color range by selecting 
the Dropper Tool in the pane and clicking on a color in your image.)

When you choose one of the options in this menu, the adjustment is only applied to that part of the image 
that is based on the lightness, hue, or saturation range specified. The Range slider expands or contracts 
the selected option, and the Highlights, Shadows, and Skin sliders protect those settings from your 
adjustments.

How blending modes work

At their basic level, blend modes determine how the pixels on one layer interact with the layers below 
it. With 24 blend modes in ON1 HDR 2023, it might be difficult to know which ones to use in any given 
situation, but they can easily be grouped into Normal (the default mode) and five categories: Darken, 
Lighten, Contrast, Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies the effect to all of the pixels in the adjustment (or effect), 
assuming the layer opacity is 100%.

The other modes apply different levels of that category’s effect using various mathematical formulas, 
and sometimes it can be hard to know which mode will work best with what photo. Most often, when 
you know how you want to apply an effect —by darkening, for example—you’ll need to perform a bit of 
experimentation with the different modes in that category to determine which mode works best.

MASTER OPACITY, BLENDING AND MASK OPTIONS

Effects also has master opacity and master 
blend mode options for the entire image stack, 
and includes a Master mask option. The Master 
Opacity slider, found at the top of the Effects 
tab, controls the strength of the composite filter 
stack against the original image—if you haven’t 
performed any other editing operations on it—or 
against the image as it has been inside the Edit 
module.

The Master Blend Mode options can be 
accessed via the gear icon at the top of the Edit 
tab. It has the same controls as the blending 
options in the individual filter panes.

To create a Master mask, click on the mask icon 
next to the Save Preset icon in the Edit tab. This 
mask works on the entire effects stack, letting 
you selectively add or remove an entire effect.

At the top of the Edit module stack, you can find a master opacity setting, as 
well as a master mask, with corresponding blending modes. Masks created here 
get applied to all of the edits you’ve made to a photo in each of the three Edit 
tabs.
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Filter Types
Effects has eight filter types available for you to use inside ON1 HDR 2023. Each filter has a set of styles in 
the top row, providing a range of popular or useful options for using that filter. You can also save your own 
preset styles by clicking the More pop-up at the end of the Styles row.

BLACK & WHITE

This pane is used to turn a color image into a monochromatic 
image, with some additional toning features.

The styles at the top of the pane represent different filter types 
often applied to an image, while the Auto button selects the black 
and white points of your image automatically. To manipulate the 
tones manually, move the color range sliders to the right (increasing 
brightness) or the left (decreasing). Alternatively, you can choose 
the Channel Mixer option from the Conversion pop-up, and use 
the slider to choose a look that accentuates the color tones you are 
most interested in.

To change the tones directly inside a photo, choose the Color 
Response tool in the pane: click on it to select the tool, then click 
and drag in the image to increase or decrease the brightness of the 
selected color range.

Tone

The Tone section of the Black & White pane lets you adjust 
brightness, contrast, highlights and shadows, whites and blacks, 
and detail, directly within the filter pane.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing 
contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing 
contrast in the shadows.

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast in the image.
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Toner

The Toner section of the filter is designed to approximate many traditional and popular darkroom-based 
paper toners, from sepia tones to platinum, selenium, coffee and more. You can choose from more than 20 
toning options via the Type pop – up menu, and adjust the combination of paper (which is represented by 
the Highlights section of the pane) and silver (represented by the Shadows). To tune your options, you can 
adjust the Hue or Amount of each setting, and use the Swap tones icon (next to the Highlights color well) to 
swap the highlights and shadows colors. The Preserve Whites and Blacks button keeps the pure whites and 
pure blacks neutral, instead of taking on the color of the toner.

Film Grain

The last section of the Black & White pane is Film Grain, which, like the Toner section, is designed to add 
a classic film grain look to your photos. To add film grain, choose from the drop-down list of popular black 
and white films. The Amount slider controls the strength of the effect, while the Size slider adjusts the 
scale of the grain.

CURVES

The Curves pane is a powerful, advanced tool for adjusting contrast 
and color in your image. The buttons at the top of the pane let you 
adjust the composite RGB channel, or you can adjust the individual 
Red, Green or Blue channels independently.

In the main part of the pane, the left side of the X-axis represents 
the dark tones in your image, while the right side represents the 
light tones. By clicking on the line at the center of the pane and 
dragging it up or down, you adjust those specific tones making 
them lighter or darker. (It is often helpful to keep an eye on the 
Histogram when making adjustments with Curves.)
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DYNAMIC CONTRAST

Dynamic contrast adds clarity—also known as tonal contrast—to 
your image, making it pop. It can be a strong effect, so it is often 
combined with masks to help lessen the effect in certain areas of 
an image (clouds in a sky, for example, often look surreal with too 
much Dynamic Contrast applied to them).

The top portion of the pane adjusts the contrast in areas of small, 
medium and large detail; moving the slider to the left decreases the 
contrast, while moving the sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect an 
image’s tonal qualities, the bottom section of the pane lets you 
make adjustments to the highlights and shadows to recover detail, 
in the white and black areas, and increase vibrance.

GLOW

This pane adds a soft-focus glow to the image. Adjustable settings 
for the Glow pane include:

• Amount: Controls the overall glow strength.

• Halo: Sets the radius of the glow effect, creating a 
fuzziness to your image’s edges.

• Mode: Lets you set the blending mode for the effect.
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HDR LOOK

This filter recreates the HDR style of tone mapping, with 
accentuated edges and sharpening. Settings include:

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast of details and edges.

• Clarity: Increases the global contrast.

• Highlights: Recovers detail in the highlights.

• Shadows: Recovers detail in the shadows.

• Vibrance: Adjusts the vibrance of muted colors.

• Glow: Adds a bright glow.

• Grunge: Adds a dark gritty look.

LUTS

The LUTs filter applies a color look-up table (LUT) to transform 
the underlying color of an image. LUTs were first used with video 
applications to provide color-grading effects to film, and they are 
increasingly popular in still photography. The Styles section has 
default effects you can apply, and you can also import your own 
LUTs, by clicking the Import button inside the filter. (HDR imports 
common LUT file formats, including .3DL and .CUBE file types.)

• Category: Lets you choose from one of the pre-installed 
LUT categories, or any imported categories .

• LUT: Displays the available LUTs within the chosen 
category.

• Contrast: Lets you adjust the underlying contrast.

• Saturation: Adds or reduces saturation.

NOTE: See page 9 for information on how to use the Extras Manager to 
import LUTs into HDR.
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SHARPENING

This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 HDR 2023 offers three algorithms for 
sharpening, High-Pass, Progressive and Unsharp Mask. Which one 
you use depends upon the image or your personal preferences. 
The styles section and the More pop-up have a wide range of 
sharpening styles to help you get started.

• Type: Chooses the sharpening method. Each sharpening 
method has its own set of sliders.

• Amount (all types): Controls the overall strength of the 
sharpening for each sharpening type.

• Halo (Unsharp Mask, High Pass): Sets the radius of the 
sharpening effect. Smaller amounts keep fine detail, 
while larger amounts can exaggerate edge detail.

• Threshold (Unsharp Mask, Progressive): Controls the sharpening effect based on contrast in 
your photo. Larger settings means that smoother areas do not get sharpened.

• Detail (Progressive only): Controls sharpening in small details.

• The Protect section protects highlight, and shadow areas and skin tones from having 
sharpening applied.

VIGNETTE

The Vignette pane creates flexible vignettes which focus a viewer’s 
eye toward the center of the image by darkening the edges of the 
frame. The buttons at the top of the pane let you quickly apply a 
vignette and then customize the look with the advanced controls. 
Styles apply common vignette types.

• Brightness: Controls how light or dark the vignette is.

• Size: Controls the size of the vignette.

• Feather: Controls the hardness of the edge of the 
vignette.

• Roundness: Controls the shape of the vignette from 
square to round.

• Type: This drop-down menu lets you select a Normal, 
Subtle, or Soft vignette effect. The Priority option will let 
you preserve highlights (using the Tone & Color pane in Develop) when applying the vignette.

The Center Tool at the bottom left of the pane lets you to select the center point of the vignette. Click 
on the tool icon to activate and then click on the area in the image you wish to make the center of your 
vignette.
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PART 6: LOCAL ADJUSTMENTS
You can easily make local adjustments to portions of an image 
in ON1 HDR 2023. You can apply these adjustments using the 
Adjustment Brush or the Adjustable Gradient, or with the Super 
Select AI or AI Quick Mask tools. You can also use the Mask AI 
selection feature in the Masking Options area of each adjustment 
pane (see page 52 for a discussion of Masking Control Options 
and the use of Mask AI to create automatic selections). 

You can create as many local adjustments as you need on an 
image by clicking on the Add Adjustment button at the top of 
the Local Adjustments section. If you’d like to use the Mask 
AI feature, hold the mouse button down on the button, and 
choose the appropriate region for which you wish to apply a local 
adjustment. ON1 HDR will create the mask and open the new 
pane in the Local Adjustments stack.

Local adjustments can be used to apply a gradient filter to darken 
a sky, for example, or to add a more complicated vignette to an 
image. Local adjustments are in essence a mask that is applied to 
a portion of your image, and you can manipulate those masks in 
powerful ways with both the blending modes and the luminosity 
options in the Local tabs.

Operations you can perform with local adjustments include 
tone (exposure, contrast, highlights and shadows, detail), color 
(white balance, saturation and vibrance) and detail (structure and 
noise). Each local adjustment layer can have completely different 
settings and work on different parts of your image. You can also 
use local adjustments to paint with color over part of a photo, to 
perform specialized tasks such as skin retouching or to replace 
the color of an object. 

Local adjustments are independent from the Develop and Effects 
tabs; you can create a local adjustment while working in Develop, 
switch to Effects, and when you click on the Local tab, your local 
adjustments remain intact.

The Local Adjustments tab
To create a local adjustment, click on the Local tab. If there are no 
local adjustment layers present, HDR will add one. If you want to 
add additional adjustment layers, click the Add Adjustment 
button. If you wish to use Mask AI to create an adjustment for a 
specific region (or regions in a photo), click and hold on the Add 
Adjustment button. This will display a list of regions in the photo, 
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and you can select the appropriate regions directly from the pop-up menu.

The top of each adjustment layer includes the following options:

• Opacity: Sets the opacity of the adjustment.

• Styles: The pane has a number of canned styles for you 
to start with, including ones for lightening or darkening 
(dodging and burning), adding vibrance, fixing teeth or 
red eye, and many more. (You can also save your own 
styles via the More pop-up menu.)

The main section of the Local tab has all of the same options 
found in the Tone & Color pane in the Develop tab: Exposure, 
Contrast, Highlights, Shadows, Detail, and Color Temperature, Tint, 
Saturation and Vibrance. In addition to those settings, the local 
adjustment pane includes a Noise slider, designed to help reduce 
noise on a targeted level (most often seen in the shadows).

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have a lot of adjustment 
layers and wish to remember which adjustment did what.

These controls work the same way inside the Local Adjustments panel. One difference is that, since a local 
adjustment is a layer that sits on top of your global adjustments, each adjustment has its own blending 
options. Blending modes determine how the selected layer blend with the items below it in the image stack.

Click on the Blending Options gear icon at the top of the Local tab to drop down the Blending Options. The 
blending option controls are:

• Blending Options: A pop-up list of blending modes. 
There are 24 common blending modes available in 
the list, including Normal, Lighten, Darken, Screen, 
Multiply, Soft Light, Hard Light, Overlay and Color.

• Apply To: This lets you apply the blending mode 
to a specific color or tonal range. The options are; 
All (the default), Highlights, Midtones, Shadows, 
Reds, Greens, Blues, Magentas, Cyans, Yellows, 
Flesh Colors, Vivid Colors and Neutrals. (You can 
also manually choose a color range by selecting the 
Dropper Tool in the pane and clicking on a color in 
your image.) 
 When you choose one of the options in this 
menu, the adjustment is only applied to that part 
of the image that is based on the lightness, hue, 
or saturation range specified. The Range slider 
expands or contracts the selected option, and the 
Highlights, Shadows, and Skin sliders protect those settings from your adjustments.

You can use the Mask AI feature to add a new local 
adjustment layer by clicking and holding on the Add 
Adjustment button at the top of the Local tab. The 
regions in the current photo will be labeled.

The Adjustment pane’s Blending controls give you extensive 
options for applying local adjustments to targeted tonal and 
color ranges in an image.
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For more information about blending modes, see page 82.

Painting with Color

The Paint with Color option at the bottom of the local 
adjustment panel lets you use the Local Adjustment 
brush to select a color and paint it into your image. It 
is designed for two situations: when you wish to apply 
softening (or evening out) to portions of an image by blending existing color, and to replace the color of an 
existing object. 

The Paint with Color section has three options, Solid Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your image by clicking on the eyedropper icon, or you 
can click on the swatch and choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a middle tone section 
of skin, and, using a low opacity setting on your brush, you can paint over parts of the skin with the brush. 
This option is also useful when you are using custom brushes to add overlays to a photo (see page 93).

WORKING WITH LOCAL ADJUSTMENTS

When adding a local adjustment layer, click on the tool you wish to use in the Tool Options bar at the top 
of the window. The Adjustment Brush is perfect for working with specific subjects or areas in an image: 
a person or primary object that you wish to brighten, shadow areas that you wish to darken, and more. 
It works in the same manner as the regular Masking Brush: you set the paint mode (in or out), brush size, 
feather and opacity, and brush in the areas you wish to paint an effect in or out.

The Adjustable Gradient is designed to apply a gradient mask over a section of an image: most commonly 
to darken a sky, for example. Because the local adjustment tools are for working on a mask, you have all of 
the masking and blending options you have throughout ON1 HDR, and you can use one or both tools—in 
addition to the Refine, Chisel and Blur Mask tools—to refine your adjustment mask as desired. 

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

TIP: To see the mask created by the Adjustable Gradient, choose Show Mask 
from the View menu. 
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Manipulating a gradient mask 

Once you’ve added a gradient to an image, you can modify it by accessing the parts of the gradient overlay: 

• To move a gradient, click on the big circle at 
the center of the gradient and drag. 

• To resize a radial gradient, click and drag on the 
solid line. 

• To adjust the feather (hardness) of the mask, 
click and drag along the dashed line. 

• To rotate the mask, click the smaller circle near 
the gradient center and drag. 

When working with local adjustment masks, all of the 
tools in the Refine group—the Refine Mask, and the Chisel and Blur tools—can be used to help give you 
create smoother and more realistic masks.

Other masking options

Every local adjustment has its own mask, and it uses the same masking options and controls found 
in throughout the Edit module. To access the mask, click on the mask icon in the title bar of the local 
adjustment layer. There you can copy and paste masks, create luminosity masks, and create masks based on 
color ranges. For specific details on working with these options, see “Masking Basics” on page 50.
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USING CUSTOM BRUSHES TO ADD OVERLAYS TO PHOTOS

One specialized use for local adjustment layers and the Paint With Color’s Solid Paint option is to add 
overlays with custom brush shapes. You can paint in stamps, watermarks, and other shapes to create 
specialized creations or enhanced photos. For example, you could use a custom cloud brush to add interest 
to a lackluster sky, or you could create your own watermark and apply it precisely. ON1 HDR comes with a 
collection of custom brushes of all kinds, and you can import any black-and-white TIF file or Photoshop-
compatible brush (.abr file) for use in the app, via the Extras Manager (see “Extras” on page 9).

Creating basic overlays with a custom brush is easy:

1. Create a new local adjustments layer by clicking on the Local tab.

2. If the Adjustment Brush isn’t selected in the Tool Options bar, select 
it, and choose a new brush from the Shape menu in the options bar.

3. Set the brush size and angle. In general, you’ll want to keep the 
Opacity and Flow high, and the Feather low (or 0), but that will 
depend upon the brush and the application.

4. From the gear menu, turn the Manual Spacing option on. Depending 
upon the brush type and the application, you’ll have to play with 
the Amount slider, but the general rule of thumb is, for stamped 
brushes, where you wish the shape to be applied singly, set the 
spacing low. If you wish to apply the brush multiple times with a 

Using custom brushes, available via the Brush Shape pop-up in the Adjustment Brush’s Tool Options bar, you can easily add realistic shapes as overlays 
to your photos, such as clouds, trees and more.
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stroke—and have clear definition between the brush shapes—set the spacing higher (see the 
spacing chart below for an illustration of the different settings).

5. Turn the Paint With Color option on and set to Solid Paint. Choose a color for brush, and 
paint as desired on the image.

Tips for using custom brushes

• The best way to begin working with brush overlays is to practice. Use some of the default 
brushes, and play with them by adding them to a photo or blank canvas.

• Use the Brush Styles option (in the Tool Options bar) to save your favorite brushes and their 
optimal settings.

• The maximum brush size in ON1 HDR is 2500 pixels.

• If you’re applying a brush as a single stamp here and there on a photo, start with a feather of 
0, and Opacity and Flow set to 100. Once you’ve set your brush size and angle, click once on 
the image.

The Paint With Color option applies to all brush strokes made on that adjustment layer. You can easily 
change the color via the color patch in the panel. If you want to apply the same stamp with different colors, 
create a new adjustment layer for each color.
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PART 7: COMBINING PHOTOS WITH LAYERS

The Layers functionality inside ON1 HDR 2023’s Edit module lets you create quick composites, blend 
multiple images together, paint in new skies or backgrounds, align layers based on their content, and much 
more. And, because Layers is tightly integrated within the Edit module, all of your work remains re-editable 
at all times: you can go back and add, change or update any setting, on any layer.

You can combine multiple photos or copies of the same photo as layers. Each layer can be moved, sized and 
masked on its own. But more than that, each layer has its own non-destructive settings—just like any photo 
in HDR, all the way back to the original raw data. That means you can use all of HDR’s editing features—
basic exposure changes, camera profiles, Effects filters and more—as part of a layered photo.

When you add a layer to a photo, HDR 
automatically creates a new document with an 
.onphoto extension, leaving your original photo 
intact. This document type contains all the 
layer information and non-destructive editing 
operations made inside HDR. 

Layers can be as simple as copies of the current photo, to apply more complex adjustments to portions of 
an image than you could with local adjustments. You can also add other documents as a layer inside the 
current document, for replacing skies or other backgrounds, for adding textures, or for when you wish to 
create complex collages. HDR supports up to 14 layers in a document.

Once you have added a layer, the entire Edit module is available for that layer. When you click on a layer, 

The Layers feature inside ON1 HDR 2023 is fully non-destructive. This means you can use all of the Edit module’s tools, tabs and filters, along with layer-
independent masking capabilities, and still preserve your original photos and can come back at any time to further enhance your creations. 
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you can add any adjustment from the four edit tabs, create masks, and more. You can use the Transform 
tool to move, rotate, and scale the contents of a layer independently from the complete document. 
(Because the Crop tool works at the document level, you can’t crop individual layers.)

ADDING A NEW LAYER

The easiest way to add a new layer to an existing image is to choose Add Layer from File item in the Layer 
menu. This will open the Add Layer window, which will two tabs in it: Extras and Folders. The Extras tab 
will display two folders, ON1 Extras and My Extras. The ON1 folder will include all of the Extras installed 
with your copy of HDR, including backgrounds, textures, borders, skies, and more. The My Extras folder 
will include any similar files you have added to HDR via the Extras Manager (as described on page 9).

If you wish to open a different file, click on the Browse button at the top of the Add Layer window, which 
will open your computer’s file selection dialog box, where you can navigate to the specific file. Any file 
compatible with ON1 HDR 2020 can be opened and added as a layer.

NOTE: If the file you add is larger or smaller than the pixel dimensions of 
the document, use the Transform tool to resize it as desired. If you wish to 
preserve the original aspect ratio of the placed file, use the Shift key to resize it 
proportionally. See page 28 for specifics on using the Transform tool.

Opening a layered Photoshop file

ON1 HDR 2023 can open most layered Photoshop files in the Edit module. What happens depends upon 
the composition and type of layers in the document:

• If the layered document has basic Photoshop layers and masks, HDR will open the document 
inside Edit, with each layer and mask visible in the Layers pane. 

• If the Photoshop file has specialty layers—smart objects, text layers, layer styles— HDR 
will flatten the visible layers and will open the file as a composite image, with a single layer 
present in the Layers pane.

In either case, HDR will convert the file to an .onphoto file, preserving your previous document.

Creating a Color Fill Layer

In addition to opening other document types, HDR can create a new layer filled with a solid color, which 
can be quite useful when working with sophisticated composites or blend modes. Choosing Add Color Fill 
Layer from the Layer menu (or clicking on the Color Fill icon in the Layers tool bar) will open the system 
color picker, where you can choose a color for your new layer.

You can change the color of any color fill layer by selecting it in the Layers pane and choosing Edit Color Fill 
from the Layers menu.
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WORKING WITH THE LAYERS PANE 

The Layers pane has three sections:

A. Layer Opacity: Reflects the opacity of 
the currently selected layer.

B. Layers: All of the layers in your 
document are listed here, with a 
thumbnail of the layer contents and the 
layer mask (if there is one); the currently 
selected layer has an colored outline 
around it (based on the Accent Color 
chosen in the System Preferences’ 
General tab). You can rename a layer by 
double-clicking on the title.

C. Layer Tools: The toolbar at the bottom 
of the Layers pane includes buttons for 
performing basic layer operations (described in more detail below). 

Layer Visibility 

A layer’s visibility can be turned on or off by clicking the button to the left of the layer thumbnail. When 
turned off, the layer has no effect on the composite image. 

Changing Opacity 

The opacity slider controls how opaque or how strong the selected layer is. The default is 100%. At lower 
settings, the layer will blend with the layer(s) under it. Altering the blending mode and opacity of a layer can 
create a wide range of color and tone effects. 

Changing the Layer Order 

You may change the order of layers by dragging and dropping layers into the order you prefer. 

Renaming Layers 

You can rename a layer by double-clicking on it. The name turns into an editable field. Type in your 
preferred name and press Enter. 

Layer pane toolbar

All of the layer commands in HDR can be 
accessed via the Layers menu and a pop-up 
menu that you get when you right-click on any 
layer. The toolbar at the bottom of the Layers pane, however, contains the basic commands you need when 
working with layers. From left, the icons represent:

• New Layer: Adds a new layer, opening the Add Layer from File window.

The Layers pane in HDR. This photo has three active layers.
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• Duplicate Layer: Makes a duplicate layer, including any Edit module adjustments made in the 
original.

• New Color Fill Layer: Creates a new color fill layer.

• Delete Layer: Deletes the currently selected layer.

• Merge Layer: Merges the currently selected layer with the one directly beneath it in the 
Layers stack.

• Blending Modes: Lets you select a blending mode for the current layer. (See page 82 for 
more about working with blend modes inside HDR.)

Other layer commands, available via the Layer menu or pop-up, include:

• Reset Layer Properties: Deletes any layer masks or transform operations you have made to 
the current layer. To reset Develop, Effects, or Portrait settings or local adjustments made to 
a layer, click the Reset Layer button at the bottom right of the main Edit module window.

• Merge Visible: Unlike the Merge Layer command, this will merge all of the visible layers—
ones with the layer visibility status set to on—in a file into a single composite layer, with all of 
the merged layers’ effect applied.

• New Stamped Layer: When you have the top layer in the stack 
selected, this option will create a new composite layer at the top of the 
stack, with all of the layers’ effect applied.

• Align Visible Layers: This will align the visible layers, based on the 
content of the layers. See page 99 for more information about this 
feature. 

Changing Blending Modes 

Blending modes determine how the selected layer blend with the layer(s) below 
it. The default blending mode is Normal. This maintains the full opacity of the upper layer. Layers also 
supports many other blending modes which can be used to alter the brightness, contrast and color of the 
image. See “Blending Modes” on page 82 for more detailed information on this topic. 

Layer Masks 

If you use any of the masking tools, a layer mask will be created automatically. Clicking on the layer’s mask 
icon will display the standard HDR mask options, and you can use all of the Edit module’s masking tools 
to create or modify layer masks. You can also copy and paste layer masks—including masks from Effects 
filters—via the Mask options section or via the Mask menu. See “Filter Masks” on page 81 and “Masking 
Tools,” starting on page 35 for more on using HDR’s masking tools.

USING THE TRANSFORM TOOL WITH LAYERS

Use the Transform tool (see page 28) at the top of the Toolbar to manipulate layers. A layer may be 
repositioned, sized or rotated using the tool. When selected, transform handles will appear on the edges of 
the selected layer. You use these transform handles to manipulate the image. You can only transform one 
layer at a time. 

Right-clicking on a layer 
brings up a list of available 
Layers operations.
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Repositioning a Layer 

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction. 

Resizing a Layer 

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center. 

You can type in the size you desire in the Tool Options bar in the width and height fields. You can also size a 
layer to fill the canvas automatically by pressing the Fill button in the Inspector. 

Rotating a Layer 

To rotate a layer, move the Transform tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use Option/ 
Alt with the left or right arrow keys to rotate a layer when the Transform tool is selected. To rotate the 
layer quickly in 90 degree increments, you can use the rotate left and rotate right buttons in the Tool 
Options bar. 

Flipping a Layer 

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options Bar. 

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options Bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options Bar or by pressing the Escape key. 

NOTE: For detailed specifics on the Transform tool’s options, see page 28.

ALIGNING LAYERS

One of HDR’s most advanced features is the ability to align multiple layers based on content. This can be a 
great aid when you’ve hand-held a group of shots, and want to blend portions of one image onto another, 
to use a better sky, for example. 

To align layers, open them in the Layers pane, and choose Align Layers from the Layer menu or pop-
up menu. HDR will then analyze the contents of the layers, and aligns them to the one with the most 
commonality. When you look at the individual layers after aligning them, you’ll see that some layers have 
been moved or rotated slightly to match the content.

An example of HDR’s layer alignment can be seen in the photos below, which are handheld shots taken two 
days apart from the same location. The top photo is the base layer, shown after alignment, but with the 
second layer hidden.
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The bottom photo shows the aligned layers, with a gradient mask blending the top part of the base layer 
with the bottom part of the other photo.  Despite the fact that the photos were shot days apart, HDR has 
aligned the photos perfectly.

The base aligned layer. 

The final aligned photos, blended together with a gradient mask from top to bottom. 
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PART 8: OUTPUT AND SHARING
While building and finishing HDR photos is probably the most important task you’ll do on a regular basis 
inside ON1 HDR 2023, there will be times when you want to “do something else” with your photos. 
Whether it’s enlarging photos for high-quality prints, sharing your photos with others or on social media, 
or printing to your desktop printer, HDR has all the functionality you’ll need to get your photos where you 
want them to be. 

In this section, you’ll find detailed information on the following topics:

• Export: The power of ON1’s patented Resize technology in an easy-to-use panel. Export your 
photos with flexibility and control.

• Print: Print your photos in any size, as individual photos, or in contact sheet form.

• Share: A quick way to share your photos (MacOS only).
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Export
Export is a special function that is available inside ON1 HDR 2023. The Export window gives 
you the power of ON1’s patented Resize technology in an easy-to-use panel, letting you export 
your photos with incredible flexibility, ease and control.

The Export window is separated into two panels: Export Presets and Export Options. The 
Options panel contains specific types of options—file renaming, destination folders, file type and more—
that you can use when you are exporting images from HDR. If you find that you are using a specific set of 
options all the time for your workflow, you can create a preset and apply that whenever you use Export.

The contents of the Export window include:

A. Export Presets: The current preset (if used), will be represented with a selection box around 
it, and the filled circle to the left of the preset name means that it will be used when the 
Export button is pressed. To use the Export Options panel without any preset applied, turn 
off all of the presets in the list, and click in the current preset once.

B. Save Preset: Lets you save the current set of export options as a preset.
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C. Naming: Renames the exported file based on criteria added to the rename box in the panel.

D. Destination: Lets you set the destination of the exported files. (required)

E. File Type: Sets the file type for each exported file. (required)

F. Resize: Adjusts the size for each image. 

G. Sharpening: Applies sharpening to the exported images.

H. Metadata: Adds/removes metadata from the export. 

I. Watermark: Lets you add a text or graphic watermark to an exported image. 

J. Export/Cancel: Starts the exporting, or cancels it and returns you to HDR.

 Export Options

NAMING

The Naming pane gives you extensive controls for creating customized filenames using tokens in the entry 
box inside the pane, as well as with any custom text entered directly into the entry box. You can use any 
combination of tokens and text in the entry box, and the Example label directly above the box will display 
what your new filename will look like, using the 
first item in the export group.

To use this feature, click the control circle to the 
left of the label in the panel. Add any custom 
text, or click the Add Token pop-up menu to add 
tokens based on information associated with the 
image, including filename data, date and time 
information, and associated metadata There are 
four submenus in the Add Token menu:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

• Sequence is intended for batch processing of images. (Not applicable when exporting from 
HDR, which processes a single image at a time.) 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file. Each change you make will be updated automatically in the Example label.
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The Presets pop-up menu at the top of the Rename window includes a set of common token combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and HDR will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found starting on page 109.

DESTINATION

The Destination pane is where you set the 
desired location for the exported images. At 
minimum, you must specify a destination folder 
for your export, but the pane has a number of 
options for adjusting the export location:

• The Folder pop-up menu lets you 
choose the same folder as the original 
images, another folder, or, can be set 
to ask for a destination every time, 
which can be helpful when you’re 
using an export preset.

• Checking the Put in Subfolder option 
will export the images to the folder—
or, create a new folder, if it doesn’t 
exist—specified by option’s text field.

• The Existing Photos pop-up is for 
those times when there might be a 
naming conflict within the destination 
folder. Replace will overwrite the file 
with the new one being exported, Skip 
will leave the destination file alone 
and not export the new file, and Keep 
Both will add a number ‘1’ to the end of the filename of the exported file, preserving both 
files.

• Generate Subfolders will subdivide the export based on the exported file’s metadata, 
creating subfolders as necessary—or, if the folders exist, placing the exported file into the 
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in 
the Naming pane.

• After Export lets you determine what to do when HDR completes the exporting process. 
Options include displaying the image location in the MacOS Finder or Windows Explorer, to 
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create a ZIP archive of the exported group, to open in another editing application, or to run a 
script.

FILE TYPE

Like Destination, File Type is the other required 
element for using Export. HDR can export in 
DNG, PSD, TIFF, JPG and PNG formats. With 
the exception of DNG and PNG, each file format 
has specific options in the pane:

• Original includes options for embedding metadata and saving an ON1 sidecar file with the 
exported images.

• JPEG includes options for JPEG quality and for attaching a color profile.

• Photoshop includes options for attaching a color profile, bit depth, and whether to flatten 
any layers in the original image.

• TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit 
depth, and to preserve transparency.

• DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

RESIZE

The Resize pane lets you adjust the finished 
dimensions of the exported photos, using the 
patented Genuine Fractals technology found 
in ON1 Resize. It has seven options for export: 
Dimensions, Long and Short Edge, Width and 
Height, Megapixels and Percentage. Each option 
has a different range of settings, and all have a 
setting for resolution (in pixels per inch, or ppi), as well as a Don’t Enlarge option, which, when set, will not 
upscale a file past its native image dimensions (but will still export the file). 

The Dimensions option is the most complex of the six Resize options, letting you set the exact pixel 
dimensions of the exported files, in terms of width and height. This option is best for when you are 
exporting single images, when all of your exported files have the same aspect ratio and orientation, or 
when you wish to fit the exported images to an exact size. 

The Common Sizes pop-up menu at the top of the pane options lets you set the final dimensions to any of a 
broad array of common paper, photographic ratio, square and video formats. You can also create your own 
specific sizes for re-use via this menu.

Click the lock icon to resize the images proportionally as you enter either the width or the height, or, if 
you wish to fit the images to an exact width and height, click the lock icon to turn it off. If an exported 
image doesn’t exactly fit the dimensions you set for Width and Height, Export will do one of two things, 
depending upon whether you have Fit in Dimensions or Fill Dimensions set in the pop-up to the right of the 
Resolution box.

The Resize pane, with the Dimensions option open.
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• Fit in Dimensions will fit the exported file inside the boundaries of the width and height 
settings.

• Fill in Dimensions will zoom the exported image to completely fill the boundaries of the width 
and height settings, essentially cropping the exported image. If the image’s aspect ratio is 
different from the width and height settings, the image will be filled from the center. 

The Dimensions options include one more setting, Rotate to Match Photo, which, when checked, will rotate 
an exported photo to maximize its orientation. For example, if you exported a group of images to fit a 
landscape orientation (longer width than height), any image that was in portrait orientation (longer height 
than width) would be rotated during export.

The remaining options in the Resize pane include:

Long Edge and Short Edge are useful when you want to lock one edge to a 
specific length or width and don’t care about the sizing of the other edge. 
Simply choose which option is the important one for your photos, enter the 
dimension, and Export will resize your images proportionally based on the 
chosen setting. When you’re exporting a group of images with different 
orientations (landscape or portrait), these options will ensure that all images 
have the same long or short edge dimension.

Width and Height will resize all of the images proportionally to the width 
or height defined, regardless of orientation. Exporting photos with different 
orientation will result in the width or height of every image being the same, 
depending upon the setting chosen.

Megapixels will export images to a specific megapixel count, while Percentage will enlarge or reduce the 
size of the exported images. Percentages below 100 will reduce the image, while those above 100 will 
enlarge the image.

SHARPENING

The Sharpening pane has two modes, Sharpen 
For and Manual. The Sharpen For pop-up 
menu lets you choose from six options, based 
upon your final intent. There are four options 
designed for print output, Glossy Paper High 
and Low, and Matte High and Low, and two 
option for display output (for social media or 
online sharing), Screen High and Low.

The Manual setting provides a bit more control 
over the output sharpening, letting you adjust 
the Amount (overall strength), Radius (detail) and Threshold (masks out areas that shouldn’t be sharpened 
based on contrast). 

Resize has seven options for 
exporting images.
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METADATA

The Metadata pane lets you set which pieces of 
metadata are exported—or not exported—with 
the images in the export set. You can choose to 
export all Metadata or by clicking the control 
circle to the right of the All Metadata label. 
If you click that label off, you can then select 
which metadata items you wish to save by 
clicking the appropriate label.

When checked, the Remove Unmanaged XMP 
button only exports metadata that ON1 recognizes as standard metadata fields; any unmanaged image 
metadata from other apps will not be included. 

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for 
size and positioning, opacity, font type, and more. 
You can import your own logos and save either 
watermark type as a preset for frequent use. 

The Watermark pane also gives you a representation 
of your chosen watermark (on the first image in your 
export group), so you can adjust the parameters of 
the watermark precisely.

To create a new watermark, turn on the pane by 
clicking on the control circle to the right of the label. 
Choose either a preset from the Presets menu or 
click on the Add Watermark button in the lower 
right of the pane and choose either Text or Logo 
from the pop-up menu. Once you’ve selected a type, 
the bottom of the pane will open with settings for 
the chosen option. If you change your mind, click the 
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you 
use either watermark files imported via the Extras 
Manager (see page 9), which will be displayed 
in the File pop-up at the top of the Logo section, or 
by clicking on the Import button to the right of the 
menu (which will add them to the menu). 

Use the Position grid at the bottom of the pane to 
place your watermark, and use the Size and Inset sliders to move it within the area chosen. The Opacity 
slider adjusts the transparency of the watermark on the final image.
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The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen 
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections 
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for 
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the web, typically over 1000 
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because 
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency, 
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text 
section of the pane has an entry box for your 
watermark text, a font selection area, and the same 
Appearance and Position options found in the Logo 
section.

The text entry box can contain multiple lines of 
custom text, and has the same token-based naming 
options found in the Naming pane (discussed on 
page 103), which can be helpful when exporting 
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and 
the font color by clicking the swatch on the left side 
underneath the font name. The text style can be 
set to bold, italic or underline, and the alignment to 
left, center or right. If you’d like to add a background 
color to the text box, turn on the Color Fill button 
on the right side of the pane.

Use the Position grid at the bottom of the pane 
to place your watermark, and use the Size and 
Inset sliders to move it within the area chosen. 
The Opacity slider adjusts the transparency of the 
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset 
for re-use later. To save a preset, adjust your Logo 
or Text settings as desired, and choose Save New 
Preset from the Presets menu. If you wish to adjust 
an existing preset at a later time—with a new logo 
file, for example—choose the appropriate preset 
from the Presets menu, make your changes, and 
choose Update Preset with Current Settings from the Presets menu. You can also rename and delete 
watermark presets from this menu.

With text-based watermarks, you can not only create simple, single-line 
watermarks showcasing your business, but you can also create 
data-driven watermarks (using tokens) for presentations and the like.
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Exporting and Export Presets
The Export window has been designed to offer as much or as 
little complexity as you would like. At its simplest, you can set the 
Destination and the File Type to your desired settings, leave all 
of the other panes alone, and click Export. HDR will remember 
your last Export setting—including anything you did in the Naming 
pane—the next time you export, so you don’t have to worry about 
which settings need to be set, and which ones don’t. You can use 
the Show/Hide buttons in the title bar of each pane of the Export 
Options panel to display only those settings you want to see.

Once you have your settings the way you’d like, you can save them 
as a preset by clicking the Save Preset option in the Preset panel 
on the left. Then, when you click that item in the Preset panel, the 
Export Options will be set to the specifications of that preset.

The Export Presets panel will display a list of the currently 
available presets. If you have selected a preset, it will have a 
selection box (in the app’s accent color) around it, and if the control 
circle is filled, the preset is on, meaning that clicking the Export 
button will export using that preset. If you don’t wish to use a 
preset, click the control circles off on all of the presets in the list.

By default, each preset will have up to three lines of explanatory 
text underneath the preset name, displaying the file type—DNG, 
PSD, TIFF—and the Destination information. This can be helpful 
when you’re scanning presets for a specific destination, but you 
can also collapse the preset to its title by clicking the Hide button 
in the title bar.

When you change the settings for a selected preset, HDR will ask 
you if you wish to update the preset with the new settings either 
when you click the Export button to start the process, or when you 
switch to another preset with the Export window.

It is possible to export more than one preset at a time. Every preset 
in the Presets panel that has the control circle set to On (filled) will 
be included in the export operation. This might be helpful to create backups on another disk, for example, 
or to build proxy versions for use while the original is being edited.

About HDR’s File-Naming Tokens
When using the Naming option in the Export window, HDR includes a broad set of tokens that you can use 
as part of the strings to build complex file names, in conjunction with any custom text you wish to enter. 
These tokens draw on image metadata, including filenames, dates taken, and EXIF and IPTC metadata 
fields, and can be used in any number of combinations.

All presets include an informational view that lists 
the export file type, the destination folder, and 
resize information. If you don’t wish to see that, 
click the Hide button to collapse the view to just 
the preset title.
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To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence, 
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the 
filename or the enclosing folder that the file resides 
in. There are three options, Filename, which adds the 
current filename of the file being worked on; Filename 
Number Suffix, which takes the index (shot) number 
from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the 
renamed (or imported) file resides.

DATE/TIME

This submenu consists of 17 combinations of date and 
time data, as taken from the image’s metadata. There 
are prebuilt date and time combinations (20220104, for 
example, for a year-month-date token) in the list, or your 
can build your own combinations out of the subtokens 
listed in this menu. 

Year data can be presented in either 4- or 2-digit 
numbers, and Month data can be presented in month 
number, full name, or 3-letter abbreviations.

You can use a combination of tokens and custom text to rename files to exacting specifications, all 
drawn from file information, metadata and more.
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SEQUENCE NUMBER

The Sequence Number tokens come into play when exporting, importing or renaming a group of image 
files, and, as such is not applicable within Effects.

METADATA

This submenu has five items, each with its own submenu. 
All of the items create the chosen token based on the 
embedded metadata for each image being renamed, 
imported or exported. The specific text pulled from the 
Camera and IPTC tokens will be visible in the Metadata 
pane’s EXIF (for camera-specific data) and IPTC (for IPTC 
data) tabs. The Ratings and Labels tokens are taken from any 
you have applied in Effects. 

NOTE: If there is no information in the specified Metadata token, it will be 
ignored during processing.

Camera

The Camera submenu includes 21 items, all of which are 
directly taken from an image’s EXIF data. Not all cameras 
capture all of the items listed, but most of them save essential 
items like exposure information, focal length and more.

Ratings and Labels

The three tokens in the Ratings and Labels submenu (shown 
below) pull information from any rating, label and like 
information stored with images opened in Effects.

The Rating token will add the number of stars an image 
is rated, while the Label token will add any color label 
information (red, yellow, green, blue, purple), and the Likes 
token will add Liked, Not Set, or Disliked to the image name.
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IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers 
much more detailed metadata information than EXIF. It historically has been used by journalists and stock 
photographers to catalog and tag photos, as well as add copyright information, captions, and other data. 
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact, 
Content, and Image. You can use these tokens if you know that an imported file has stored IPTC Metadata 
information.   
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Printing
HDR 2023 has a flexible print engine that can print photos at any size. You can print photos individually; or 
multiple versions of a photo, package style, on a single piece of paper. You can even print when using HDR 
as a plugin from Lightroom.

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A. Preview: Displays the photo or photos being printed.

B. View Selector: The middle two icons are not applicable inside HDR; the icon on the far right 
turns soft proofing on and off.

C. Page view: Displays the number of pages being printed. (Not applicable in HDR 2023.)

D. Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

E. Print Area pane: Contains options for fitting and selecting the print image size.

F. Watermark pane: For adding a watermark to printed photos.

G. Sharpening: Options for sharpening during the print process.

H. Print/Cancel: Print One (current image), Print All, or Cancel.
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NOTE: The print engine in HDR 2023 is based upon the engine inside ON1 
Photo RAW 2023, which has the capability to print multiple photos at a time. 
Because HDR can only edit a single photo at a time, some options, like contact 
sheets and some view settings, are not applicable in ON1 HDR.

The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that has 
between 240 and 360 ppi. (HDR will use its internal resampling 
engine to ensure that your photo is at the print resolution you 
choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. 

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. (You can use HDR’s Soft Proofing 
feature to look at out-of-gamut colors in your photos. See “Soft Proofing” on page 61 for more.)

NOTE: HDR’s Print feature will work with borderless printing options as well. 
Be sure to choose your printer’s borderless options in the page setup pop-up. 
Different printers will have specific borderless settings, so check the manual to 
see how to turn borderless printing on.

Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, 
click on the File icon at the top of the pane. HDR will ask you for a filename and a location to save the file. 
Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When you 

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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choose Print, HDR will create a PDF of the photo (or photos) and save it with the name and destination you 
specified earlier.

PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually or package-style. (The 
contact sheet option, while present, is not applicable in HDR, as it 
is largely designed to gang-print a set of different photos.)

The top of the pane includes preset styles for either fitting the 
current photo inside the size of the print, or filling the entire size 
of the print. It also includes options for printing at common print 
sizes, including 8x10, 5x7, 4x6; and options for printing to a contact 
sheet. You can also create custom print sizes via the Custom 
section at the bottom of the pane; just set the width and height of 
the print size, and whether you wish to fit the image to the print 
size, or to fill the frame with it. If you would like to save this print size as a style, click on the More pop-up 
at the top of the pane, and choose Save as New Style from the menu. You’ll then be able to recall that style 
from the More pop-up whenever you print.

If you are printing multiple copies of a single photo, HDR will attempt to put as many photos at your chosen 
print size on the paper size as defined in the Printer pane. To print only one photo per page, click that 
option at the bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. Otherwise, 
it could appear pixelated on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in the Edit module. 

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need 
to play with the settings here; performing test prints on small 
sections of a photo can often be quite helpful in determining the proper level of sharpening in a print.

Use the Sharpening pane to add additional 
sharpening to your printed image.
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Other Sharing Options (MacOS Only)
The MacOS version of ON1 HDR 2023 includes a number of photo-sharing options, which can be 
accessed from the Share pop-up menu in the lower right side of the HDR  window. These options 
include:

• Mail: Creates a new email message in Apple Mail with the shared photo.

• AirDrop: Uses Apple’s AirDrop networking feature to share with local 
MacOS or iOS devices. 

• Notes: Adds the shared photo to Apple’s Notes app. You can choose to 
create a new note, or add the photo to an existing note.

• Messages: Shares photo to Apple’s Messages app.

• Add to Photos: Adds the photo to Apple’s Photos app.

All of the sharing options perform the same operation: HDR exports a full-size JPEG of the selected photo 
and shares it with the selected target from the list. 
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Edit Menus
ON1 HDR (MacOS Only)

• About ON1 HDR: Opens the About box and displays your 
version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)

• Quit ON1 HDR: Quits ON1 HDR 2023.

File Menu

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using a 
preset from the hierarchical menu, bypassing the Export 
window.

• Export with Previous: Exports the current selection with the 
last-used Export setting, bypassing the Export window.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.

• Undo Delete: [unused]

• Redo Delete: [unused]

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the current 
location.

• Delete: [unused]

• Revert: Reverts to the original state of the current photo.

• Keyboard Shortcuts: Lets you modify the keyboard shortcuts 
used by ON1 HDR.

• Preferences (Windows): Opens the Preferences dialog.
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Layer Menu

• Add Layer from File: Lets you add a new file to the current 
document as a layer.

• Add Color Fill Layer: Adds a new layer consisting of a solid 
color.

• Edit Color Fill: Lets you change the color of a selected color 
fill layer.

• Delete: Deletes the currently selected layer.

• Duplicate: Duplicates the currently selected layer.

• Reset Layer Properties: Removes any applied layer masks or 
transforms to the current layer.

• Merge Layer: Merges the current layer with the one beneath 
it.

• Merge Visible: Merges all of the visible layers into a new, 
merged layer.

• New Stamped Layer: Merges the visible layers into a new, 
composite layer, leaving the visible layers intact.

• Align Visible Layers: Aligns visible layers based on their 
content.

Photo Menu

• Rotate 90 Degrees CW: Rotates an image clockwise by 90°

• Rotate 90 Degrees CCW: Rotates an image counterclockwise 
by 90°

Mask Menu

• Invert Mask: Inverts the mask, what was hidden is revealed 
and vice versa.

• Reset Mask: Resets the mask to plain white.

• Copy Mask: Copies the mask.

• Paste Mask: Pastes the mask.

• Create Luminosity Mask: Creates a luminosity layer mask 
based off of a photo’s black or white tonal values.

• Show Mask: Displays the current mask either as a red overlay 
or as grayscale.

• View Mode: Sets the Show Mask mode to either red overlay 
or grayscale, or to only show the overlay when you are 
brushing with a masking tool.
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Settings Menu

• Reset All Settings: Resets all of the Edit module settings on a 
photo. (Changes to Reset Layer when you have multiple layers in 
a document; this will reset all of the settings only on that layer.)

• Reset Develop Settings: Resets settings applied in Develop.

• Reset Effects Settings: Resets settings applied in Effects.

• Reset All Retouching Tools: Resets retouching applied in Edit. 

• Reset Local Adjustments: Resets any local adjustments.

• Reset Crop: Resets any cropping made to a photo.

• Save Settings as Preset: Saves the editing settings of the 
selected photo as a preset.

• Update Preset with Current Settings: If an image with a 
preset has had some settings changed, this lets you update 
the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1’s Photo Presets web page.

• Save Settings: Saves the current state of your edits, in case of 
a crash.

View Menu

• Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you 
to see every pixel in the image. This is useful when making 
precision adjustments.

• Preset Browser: Sets the browser view to 1, 2 or 3 columns.

• Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.

• Show Focus Mask: Displays a green overlay on those portions 
of the current image that are in focus.

• Show Preview: Toggle to enable or disable the preview.

• Compare: Displays an adjustable split-screen view of the 
current image, with the Before view on the left side of the 
preview area.
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• Preview Background Color: Lets you set the background color 
options.

• Enable Soft Proofing: Turns on soft proofing for the current 
image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display profiles; 
choosing a profile will apply soft proofing for that profile’s 
paper type.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, HDR will set the 
white point and black point of the display to account for that 
of the chosen profile.

Window

• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Full Screen Preview: Displays the current photo full-screen, 
without any additional interface elements.

• Navigator: Hides/shows Navigator, Loupe, Histogram, Info.

• Layers: Collapses the Layers pane.

• Solo Mode: Keeps only one pane open at a time.

• Show Layers: Completely hides/shows the Layers pane.

• Open Quick View Browser: Opens the Quick View Browser 
overlay for the selected preset category.

• Show Bumper Labels: Hides/reveals the text labels in the 
module selector.

• Show Browser Panel: Hides/shows the Browser Panel.

• Show Control Panel: Hides/shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit depth 
of the open image.

Help

• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub inside ON1 HDR.

• ON1 HDR 2023 Online Help: Opens ON1.com support page 
in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.
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• Getting Started: Opens the initial HDR startup screens.

• Check for Updates: Checks the ON1 update server to see if 
you are running the current version. If there is an update, you 
will be notified/walked through the update process.

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 HDR 2023.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 HDR (Windows Only): Opens the about box with 
the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 HDR 2023.
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Preferences
ON1 HDR has a number of system-wide settings that you can set via the Preferences window. To access 
Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences from 
the ON1 HDR 2023 menu (MacOS) or the Edit menu in Windows. The Preferences window has four tabs—
General, Files, Plugins, System—and are described below.

GENERAL SETTINGS

The General settings tab adjusts basic 
settings for the HDR workspace, including 
background color, scrolling controls and 
more.

Scrolling Controls

Lets you select how the mouse scroll wheel 
or scrolling gesture works. The options are:

• None: Default.

• Preview Zoom: Adjusts the zoom of 
the preview window. Scrolling up increases the zoom, scrolling down decreases the zoom.

• Preview Pan: Pans the image, like using the pan tool or navigator. It is important that the panning is 
comfortable, not too fast or slow or jerky.

• Brush Size: Adjusts the size of the current tool if relevant, such as a brush tool.

Font Size

Sets the size of the text in the basic HDR workspace (labels, panes and pop-up menus) to one of three 
general sizes: Small, Medium, Large. 

NOTE: When changing the font size, you must quit and restart HDR for the 
the new setting to take effect.

Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the HDR interface.
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Application Language

Lets you change the display language for ON1 HDR 2023. Auto will use your system’s default language.

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.

FILES

The Files tab has settings for saving sidecar files, 
as well as for procession options of raw photos 
opened in ON1 HDR.

Sidecar Options

Click this box if you wish ON1 HDR 2023 to 
create ON1-specific ‘sidecar’ files when you are editing images. This is helpful if you are using the same 
image library with multiple computers (on an external hard drive, for example), and want your edits to be 
visible on each machine.

Default Processing

The Default processing section contains three options, for lens correction, base level raw-file corrections, 
and applying camera-based presets. The first, Apply Lens Correction Automatically, will use the lens 
correction automatically on any raw photo when you view it in Detail, Filmstrip or Compare modes. The 
Disable Base Corrections option turns ON1’s basic raw-file correction settings off. This can be helpful for 
scientific/technical photography, time-lapse, and other specialized applications.

PLUG-INS

This tab is specific to using HDR as a plugin.

General

Checking the “Leave ‘ON1 Effects 2023’ open 
when done will keep the app open after you’ve 
edited an image via a plugin.

Lightroom

Lets you choose the file options for files opened 
via the Plug-in Extras menu:



ON1 HDR 2023 User Guide Part 9: HDR 2020 Reference 126

• File Type: This determines what type of file will be created. The default is PSD, which does not support 
re-editability. You can also select Smart Photo PSD, JPG or TIFF, if you prefer those formats. One other 
option, Same as Source, will edit the original file; if that file is a Smart Photo PSD, it will open in that 
format (see page 8 for more on the Smart Photo format).

• Color Space: The color space menu determines which RGB working color space is used; Adobe RGB 
1998, sRGB or ProPhoto RGB.

• Bit Depth: Sets the exported file’s bit depth to either 8 or 16 bits per pixel.

• Resolution: Determines the resolution of the newly created file.

• Stack with Original: When enabled, the new image is stacked with the original image upon return to 
Lightroom from HDR.

• Use Original for Single PSDs: When enabled, if you select a single image in PSD format, the original file 
will be edited, rather than having a copy made.

• Ask Every Time: When checked, Lightroom will present these export copy options whenever you chose 
an item from the Plug-In Extras submenu. Turning this option off will bypass the file-export window 
inside Lightroom, using the options set in Plug-In Preferences window.

SYSTEM

The System tab sets performance-related 
characteristics of HDR 2023.

AI processor

Sets the processing option for AI-based 
operations. By default, the option is set to Auto, 
which uses the best combination of system 
resources to process tasks. If you are noticing 
some performance issues with HDR, you can try 
setting the options to either your CPU or your 
graphics card.

Memory Usage

• System Usage: Specifies the amount of RAM that is used by the application. The maximum (default 
value) is 80%.

• VRAM Usage: Specifies the amount of video memory (VRAM) that is used by the application. The 
maximum (default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed editing operations while you’re 
running HDR. This is helpful if your system drive has limited space and wish to use a faster external drive as 
a cache. This cache information is purged each time you quit the application.
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Performance

The Performance section is designed to help you optimize HDR for your specific setup. The adjustments 
you can make are as follows:

• Video Card Strength balances updating the preview of the image and the movement of brushes and 
gradient tool overlays. If your brush is sticking try turning it down. If you have a high-end video card try 
turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to improve 
performance of panning.

• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and 
caching. This can greatly improve performance. It is on by default for systems that support it. It may be 
disabled on lower-end GPUs.
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